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PlantPAx Distributed Control System - Templates User Manual

Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to
be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be
impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use
or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for
actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software
described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is
prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

WARNING: |dentifies information about practices or circumstances that can cause an explosion in a hazardous environment, which
may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage,
or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

> P

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

Labels may also be on or inside the equipment to provide specific precautions.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage
may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or mator, to alert people that surfaces may reach
dangerous temperatures.

ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc
Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory
requirements for safe work practices and for Personal Protective Equipment (PPE).

B> B P

N
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Preface

Summary of Changes

Rockwell Automation Publication 9528-UMOO1L-EN-P - August 2023

This template user manual describes how to leverage virtual image templates
when deploying a virtualized PlantPAx® Distributed Control System (DCS).
PlantPAx virtual image templates are pre-configured, virtual system elements
of your PlantPAx system.

This manual also describes how to manage and configure templates as
individual virtual system elements, and how to configure them to work
together.

« Define and Procure - Helps you understand the elements of the
PlantPAx system to make sure that you buy the proper components.

« Install - Provides direction on how to implement the PlantPAx system
architecture to help develop your application.

« Prep - Provides guidance on how to get started and learn the best
practices for developing your application.

« Develop - Contains the application-specific libraries and objects that
are used to construct your application that resides on the PlantPAx
architecture.

« Operate — Provides guidance on how to verify and maintain your
systems for the operation of your plant.

This publication contains the following new or updated information. This list
includes substantive updates only and is not intended to reflect all changes.

Topic Page
Pass-C catalog number changed to 9528-PASSCVTENM 9
Purpose of this Manual

Virtualization is the abstracting of the operating system from the hardware to
enable running multiple virtual machines on one piece of hardware. This
manual shows how to use templates to configure virtualized system elements.

Virtual image templates are provided for the following PlantPAx system
elements:

«  Process Automation System Server (PASS)

« Engineering Workstation (EWS)

«  Operator Workstation (OWS)

«  SQL Server - AppServ-Info (SQL)

«  Process Automation Domain Controller (PADC)

« Historian Server - AppServ-Info (Historian)

« Batch Management Server - AppServ-Batch

« Asset Management Server - AppServ-Asset

«  Operator Workstation Application Server - AppServ-OWS

«  Engineer Workstation Application Server - AppServ-EWS

«  Process Automation System Server Consolidated (PASS-C)



Before you Begin

Microsoft Operating System
Software Licensing

IMPORTANT  Our templates can be used with any virtualization software. We use
VMware for the procedures in this document.

Obtain PlantPAx virtual image templates by the following methods:
« Media- Order a physical copy of the virtual image template. End User is
responsible for the proper Microsoft® licensing.

«  Electronic Software Delivery (ESD) - Download an electronic copy of
the virtual image template from the Product Compatibility and
Download Center (PCDC) website.

Virtual servers require Microsoft OS License Keys for Windows® Server
operating systems.

Virtual workstations require a Microsoft OS License Key for Windows
operating systems.

7 lip: Remote Desktop Services uses its own method of licensing clients that log
&)  ontoRemote Desktop Services servers. This method is separate from licensing
) for the Windows Server family of operating systems. Therefore, AppServ-0WS

and AppServ-EWS Remote Desktop Connections must receive a valid license.
This license is issued by a Remote Desktop Licensing Server before they can log
on to a Remote Desktop Session Host or Connection Broker.

For licensing of these components, contact your Microsoft distributor.

FactoryTalk® Activation Certificates contain serial numbers and product keys
for the Rockwell Automation products that correspond to the templates.

See PlantPAx Virtual Image Template Catalog Numbers on page 9

IMPORTANT  If you already own individual product activations, these activations
can also be used to activate the virtual image templates.

A domain controller is recommended to be configured and accessible on the
network.

vSphere Web Client is used to deploy virtual machines.

vCenter server is optional and enables you to create your own virtual image
templates and increase your ability to manage a virtualized control system.

Each server or workstation instance that is deployed from a template needs its
own Microsoft operating system license and Rockwell Automation® software
licenses.

The End User is responsible for properly licensing a Microsoft OS for each
template deployed. Additional licenses can be purchased from your Microsoft
distributor.

8 Rockwell Automation Publication 9528-UMOO1L-EN-P - August 2023



PlantPAx Virtual Image

Template Catalog Numbers

Virtual Template Cat. No. Description

USB device contains the virtual image template for the PASS. The End User is responsible for acquiring the

PASS 9528-PASSVTENM appropriate Microsoft 0S license for server 2019. All required Rockwell Automation software is pre-installed but not
activated.
USB device contains the virtual image template for the engineering workstation. The End User is responsible for

EWS 9528-EWSVTENM acquiring the appropriate Microsoft 0S license for Windows 10. All required Rockwell Automation software is pre-
installed but not activated.
USB device contains the virtual image template for the OWS. The end use is responsible for acquiring the

ows 9528-0WSVTENM appropriate Microsoft 0S license for Windows 10. All required Rockwell Automation software is pre-installed but not

activated.

AppServ-0WS, AppServ-
EWS

9528-APPXWSENM

USB device contains the virtual image template for AppServ-0WS and AppServ-EWS. The End User is responsible for
acquiring the appropriate Microsoft 0S license for server 2019. All required Rockwell Automation software is pre-
installed but not activated. You must also purchase the appropriate Windows CAL from a Microsoft distributor.
IMPORTANT: Each client needs an RDS CAL license.

AppServ-Info (Historian)

9528-APPHISENM

USB device contains the virtual image template for AppServ-Info (Historian). The End User is responsible for
acquiring the appropriate Microsoft 0S license for server 2019. All required Rockwell Automation software is pre-
installed but not activated.

AppServ-Asset

9528-APPASMENM

USB device contains the virtual image template for AppServ-Asset. The End User is responsible for acquiring the
appropriate Microsoft 0S license for server 2019. All required Rockwell Automation software is pre-installed but not
activated.

AppServ-Info (SOL)

9528-APPSQLENM

USB device contains the virtual image template for AppServ-Info (SQL). The End User is responsible for acquiring
both the appropriate Microsoft 0S license for server 2019 and Microsoft SQL server.

AppServ-Batch

9528-APPBATENM

USB device contains the virtual image template for AppServ-Batch. The End User is responsible for acquiring the
appropriate Microsoft 0S license for server 2019. Most required Rockwell Automation software is pre-installed but
not activated. The FactoryTalk® Batch software is not pre-installed.

Domain controller

9528-PADCVTENM

USB device contains the virtual image template for a Domain controller. The End User is responsible for acquiring
the appropriate Microsoft 0S license for server 2019. You must also purchase the appropriate Windows CAL from a
Microsoft distributor.

PASS - C (Consolidated)

9528-PASSCVTENM

USB device contains the virtual image template for a consolidated PASS. The consolidated PASS includes
FactoryTalk® Historian, Asset Management, OWS, and EWS. The End User is responsible for acquiring the appropriate
Microsoft OS license for server 2019. A Rockwell Automation license is required for software activation.
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Build Details

PlantPAx Virtual Image Template

Element

Category

Description

Process Automation
System Server (PASS)

Operating system

Microsoft Windows server 2019 Standard

Rockwell Automation software

FactoryTalk® Services Platform

- FactoryTalk® Services Platform software, version 6.31.00

- FactoryTalk® Activation Manager software, version 5.00.11

- FactoryTalk® Linx software, version 6.31.00

FactoryTalk® View Site Edition Client software, version 13.00.00
FactoryTalk® View Site Edition Server software, version 13.00.00
FactoryTalk® View Studio Enterprise software, version 13.00.00
FactoryTalk® Alarms and Events software, version 6.31.00
FactoryTalk® Diagnostics software, version 6.31.00

FactoryTalk® Historian SE Live Data Interface, version 8.00.00
Rockwell Automation Windows Firewall Configuration Utility, version 1.00.15

Engineering
Workstation (EWS)

Operating system

Microsoft Windows 10 Enterprise LTSC 2019

Rockwell Automation software

« FactoryTalk Services Platform

- FactoryTalk Services platform software, version 6.31.00

- FactoryTalk Linx software, version 6.31.00

- RSLinx® Classic software, version 4.30.00

- FactoryTalk Activation Manager software, version 5.00.11
FactoryTalk View Site Edition Client software, version 13.00.00
FactoryTalk View Site Edition Server software, version 13.00.00
FactoryTalk View Studio Enterprise software, version 13.00.00
FactoryTalk Alarm and Events software, version 6.31.00
FactoryTalk Diagnostics software, version 6.31.00

RSLogix 5000° Professional software, versions 20.05.00
Studio 5000 Logix Designer® application, versions 35.00.00, 34.00.00, 33.00.00, 32.04.00,
31.02.00, 30.02.00, 28.03.00, 24.02.00, 21.03.02

« FactoryTalk® Logix Echo™

« Studio 5000° Application Code Manager, version 4.02.00
RSNetWorx™

- RSNetWorx for EtherNet/IP™ software, version 28.01.00

- RSNetWorx for ControlNet® software, version 28.01.00

- RSNetWorx for DeviceNet® software, version 28.01.00
FactoryTalk® AssetCentre

- FactoryTalk AssetCentre Client software, version 11.00.00
FactoryTalk Historian SE Management Tools, version 7.00.00
Studio 5000° Logix Emulate™, version 33.00.00

ControlFLASH Plus™ software, version 3.01.00

ControlFLASH™ software, version 15.03.00

Rockwell Automation Windows Firewall Configuration Utility, version 1.00.15

Additional third-party software

Microsoft SQL Server 2012 SP4 Management Tools
Microsoft SQL Server 2012 SP4 Client Connectivity

Operator Workstation
(ows)

Operating system

Microsoft Windows 10 Enterprise LTSC 2019

Rockwell Automation software

« FactoryTalk Services Platform
- FactoryTalk Services platform software, version 6.31.00
- FactoryTalk Linx software, version 6.31.00
- RSLinx Classic software, version 4.20.00
- FactoryTalk Activation Manager software, version 5.00.11
» FactoryTalk Diagnostics software, version 6.31.00
« FactoryTalk View Site Edition Client software, version 13.00.00
« FactoryTalk Alarm and Events software, version 6.31.00
» FactoryTalk AssetCentre Client software, version 11.00.000
« Rockwell Automation Windows Firewall Configuration Utility, version 1.00.15

Process Automation
Domain Controller
(PADC)

Operating system

Microsoft Windows server 2019 Standard

10
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Element

Category

Description

Application Server
OWS (AppServ-0WS)

Operating system

Microsoft Windows server 2019 Standard

Rockwell Automation software

« FactoryTalk Services Platform
- FactoryTalk Services platform software, version 6.31.00
- FactoryTalk Linx software, version 6.31.00
- RSLinx Classic software, version 4.20.00
- FactoryTalk Activation Manager software, version 5.00.11
« FactoryTalk View Site Edition Client software, version 13.00.00
« FactoryTalk Diagnostics software, version 6.31.00
« FactoryTalk Alarm and Event software, version 6.20.00
« FactoryTalk AssetCentre Client software, version 11.00.00
« Rockwell Automation Windows Firewall Configuration Utility, version 1.00.15

Application Server
EWS (AppServ-EWS)

Operating system

Microsoft Windows server 2019 Standard

Rockwell Automation software

« FactoryTalk Services Platform

- FactoryTalk Services platform software, version 6.31.00

- FactoryTalk Linx software, version 6.31.00

- RSLinx Classic software, version 4.20.00

- FactoryTalk Activation Manager software, version 5.00.11
FactoryTalk View Site Edition Client software, version 13.00.00
« FactoryTalk View Site Edition Server software, version 13.00.00
« FactoryTalk View Studio Enterprise software, version 13.00.00
« FactoryTalk Alarm and Event software, version 6.20.00
FactoryTalk Diagnostics software, version 6.31.00
RSLogix 5000° Professional software, versions 20.05.00
Studio 5000 Logix Designer® application, versions 35.00.00, 34.00.00, 33.00.00, 32.03.00,
31.02.00, 30.02.00, 28.03.00, 24.02.00, 21.03.02
« FactoryTalk® Logix Echo™
« Studio 5000°® Application Code Manager, version 4.02.00
RSNetWorx
- RSNetWorx for EtherNet/IP software, version 28.01.00
- RSNetWorx for ControlNet software, version 28.01.00
- RSNetWorx for DeviceNet software, version 28.01.00
FactoryTalk AssetCentre
- FactoryTalk AssetCentre Client software, version 11.00.00
FactoryTalk Historian SE Management Tools Suite, version 8.00.00
Studio 5000° Logix Emulate™, version 34.00.00
ControlFLASH Plus™ software, version 4.01.00
ControlFLASH™ software, version 15.06.00
Rockwell Automation Windows Firewall Configuration Utility, version 1.00.15

Additional third-party software

Microsoft SQL Server 2019 Management Tools
Microsoft SQL Server 2019 Client Connectivity

Application Server
Historian (AppServ-
Info Historian)

Operating system

Microsoft Windows server 2019 Standard

Rockwell Automation software

FactoryTalk Services Platform

- FactoryTalk Services platform software, version 6.31.00

- FactoryTalk Activation Manager software, version 5.00.11

- FactoryTalk Diagnostics software, version 6.31.00
FactoryTalk Alarm and Events software, version 6.31.00
FactoryTalk Historian Site Edition Server, version 8.00.00
FactoryTalk Historian ActiveView software, version 8.00.00
FactoryTalk Historian DataLink software, version 8.00.00
FactoryTalk Historian Management software, version 8.00.00
FactoryTalk Historian ProcessBook software, version 8.00.00
FactoryTalk Historian SE Live Data Interface, version 8.00.00
Rockwell Automation Windows Firewall Configuration Utility, version 1.00.15
FactoryTalk Linx software, version 6.31.00

Rockwell Automation Publication 9528-UMOO1L-EN-P - August 2023
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Element

Category

Description

Application Server
Asset Management
(AppServ-Asset)

Operating system

Microsoft Windows server 2019 Standard

Rockwell Automation software

« FactoryTalk Services Platform
- FactoryTalk Services platform software, version 6.31.00
- FactoryTalk Diagnostics software, version 6.31.00
- FactoryTalk Linx software, version 6.31.00
- RSLinx Classic software, version 4.20.00
- FactoryTalk Activation Manager software, version 5.00.11
- FactoryTalk Alarm and Events software, version 6.31.00
« FactoryTalk AssetCentre
- FactoryTalk AssetCentre Server software, version 11.00.00
- FactoryTalk Asset Centre Client software, version 11.00.00
« Rockwell Automation Windows Firewall Configuration Utility, version 1.00.15

Additional third-party software

Microsoft SQL Server Express 2016 SP2 Advanced (includes Management Studio)

Application Server
Information SQL
(AppServ-Info-SQL)

Operating system

Microsoft Windows server 2019 Standard

Microsoft SQL Server Standard 2019 (includes
Management Studio)

Microsoft SQL Server Standard 2019 (includes Management Studio)

Application Server
Batch Management
(AppServ-Batch)

Operating system

Microsoft Windows server 2019 Standard

Rockwell Automation software

« FactoryTalk Services Platform
- FactoryTalk Activation Manager software, version 5.00.11
- FactoryTalk Diagnostics software, version 6.31.00
- FactoryTalk Services platform software, version 6.31.00
- RSLinx Classic software, version 4.20.00
« FactoryTalk Batch, version 15.00.00
« Rockwell Automation Windows Firewall Configuration Utility, version 1.00.15

PASS-C (consolidated)

Operating system

Microsoft Windows server 2019 Standard

Rockwell Automation software

FactoryTalk Services Platform

- FactoryTalk Services platform software, version 6.31.00

- FactoryTalk Activation Manager software, version 5.00.11

- FactoryTalk Linx software, version 6.31.00

- RSLinx Classic software, version 4.20.00

FactoryTalk View Site Edition Client software, version 13.00.00
FactoryTalk View Site Edition Server software, version 13.00.00
FactoryTalk View Studio Enterprise software, version 13.00.00
FactoryTalk Alarm and Events software, version 6.31.00
FactoryTalk Diagnostics software, version 6.31.00

FactoryTalk Historian SE Live Data Interface, version 8.00.00
Rockwell Automation Windows Firewall Configuration Utility, version 1.00.15
FactoryTalk Historian SE software, version 8.00.00

FactoryTalk AssetCentre Server, version 11.00.00

FactoryTalk AssetCentre Client, version 1.00.00

RSLogix 5000 Professional software, versions 20.05.00

Studio 5000 Logix Designer application, versions 35.00.00, 34.00.00, 33.00.00, 32.03.00,
31.02.00, 30.02.00, 28.03.00, 24.02.00, 21.03.02

« Studio 5000 Application Code Manager, version 4.02.00

« ControlFLASH software, version 15.06.00

» ControlFLASH Plus software, version 4.01.00

Additional software

SOL Server Express 2016

12
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Additional Resources

These documents contain additional information concerning related products

from Rockwell Automation.

Resource

Description

EtherNet/IP Network Devices User Manual, ENET-UM006

Describes how to configure and use EtherNet/IP devices to communicate on the EtherNet/IP
network.

Ethernet Reference Manual, ENET-RM002

Describes basic Ethernet concepts, infrastructure components, and infrastructure features.

System Security Design Guidelines Reference Manual, SECURE-RMO01

Provides guidance on how to conduct security assessments, implement Rockwell Automation
products in a secure system, harden the control system, manage user access, and dispose of
equipment.

Industrial Components Preventive Maintenance, Enclosures, and Contact Ratings
Specifications, publication IC-TD002

Provides a quick reference tool for Allen-Bradley® industrial automation controls and
assemblies.

Safety Guidelines for the Application, Installation, and Maintenance of Solid-state
Control, publication_SGI-1.1

Designed to harmonize with NEMA Standards Publication No. ICS 1.1-1987 and provides general
guidelines for the application, installation, and maintenance of solid-state control in the form of
individual devices or packaged assemblies incorporating solid-state components.

Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1

Provides general guidelines for installing a Rockwell Automation industrial system.

Product Certifications website, rok.auto/certifications.

Provides declarations of conformity, certificates, and other certification details.

You can view or download publications at rok.auto/literature.
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https://literature.rockwellautomation.com/idc/groups/literature/documents/um/enet-um006_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/enet-rm002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/enet-rm002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/ic-td002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/in/sgi-in001_-en-p.pdf
www.rockwellautomation.com/literature
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/1770-in041_-en-p.pdf
https://rok.auto/certifications

Notes:
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Chapter 1

Virtual Image Templates

Basics of Virtualization

Rockwell Automation offers virtual image templates as an option to deploy a
virtualized PlantPAx® system. The PlantPAx Virtual Image Templates deliver
all system elements as pre-installed, drop-in virtual machines. The industry
also refers to virtualized system elements as virtual appliances. However, in
this manual, virtual system elements are referred to as virtual image templates
because you can use them to deploy as many virtual appliances as you want.

The virtual image templates are

delivered as an Open Virtual Virtual
Appliance (OVA) file on USB devices
or via the Web. With OVA files, you
can use any virtualization platform
for deployment. The guidelines that
are contained in this manual are for

Hypervisor Q

setup and deployment of the Host
templares in a VMware vSphere VSphEﬁE_W eb
environment.

The virtual image templates help to reduce validation costs and initial
engineering time, enhance scalability, simplify upgrades, and patch
management. Only one copy of the virtual image templates is needed for a
project.

Some of the benefits of a virtualized PlantPAx system include the following:

« Increased energy savings

« Extended system life

« Reduced system footprint and hardware cost
« Increased up time and availability

« Self-contained simulation and engineering

« Faster server provisioning

« Improved disaster recovery

Flexibility and ease of deployment are key when designing a virtual
infrastructure. Both intangibles are a part of the PlantPAx system.

Rockwell Automation Publication 9528-UMOO1L-EN-P - August 2023 15



Chapter 1 Basics of Virtualization

Choose a Hypervisor

Install a Hypervisor

16

A hypervisor is computer software that manages a physical host server and
allocates computing resources to run multiple guest operating systems. Each
guest is a virtual machine (VM) that runs in the host server with its own
memory, storage, and CPU allocation on the host.

IMPORTANT  Rockwell Automation recommends and tests on VMware
hypervisors. Other hypervisors are available; however, we describe
using PlantPAx image templates on the YMware vSphere ESXi
hypervisor.

For a production environment, we recommend a minimum of a
VMware vSphere Essentials Kit. The vSphere Essentials Kit supports
6 CPUs and a vCenter server access to key virtual components at a
minimum cost.

Depending on the make and model of your host server, the hypervisor
installation files are available directly from the manufacturer's website. These
custom downloadable packages often contain drivers for specialized
hardware. If a customized download is not available from the vendor, you can
download the hypervisor directly from the VMware website.

1. Login to the vendor or VMware website.

2. Find the support or downloads section and search for hypervisors.

Select the latest version of hypervisor that is supported on your server
hardware or choose the version of which you have licensing.

4. Download the hypervisor.

This section describes how to install the VMware vSphere ESXi hypervisor to a
host server. To install the hypervisor on your server, we recommend that you
copy the installer image (.iso) to a DVD. If desired, you can also copy the
installer image (.iso) to a USB drive (at least 1 GB).

Copy Installer Image to DVD

1. Right-click the downloaded installer image and choose Burn disk image.
|5 |w|o n_o-i\‘_-,:Eii!&g‘

@\_J'. ¥ Libraries » Documents » Downloads » « | 44 || Seorch Do P
File Edit View Tools Help
Organize > Sharewith »  New folder =~ [ ®

I Favorites . Documents library

- Libraries

*| Documents

@ Muzsic

| Pictures

B videos

1M Computer
&L RaWT121001 (C)
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Chapter 1 Basics of Virtualization

2. Select the DVD drive where you will write the data, and select Burn.
Select Close when the DVD is completed.

(Y Windows Diss image @ .

Disc image file:  VMware-VMvisor-Installer-6.0.0.update(

Disc burner: DVD R Drive (D:) =

Status

Verify disc after burning

Copy Installer Image to USB Drive

IMPORTANT  Before starting this procedure, make sure that the USB drive has
enough space on it to hold the hypervisor ‘ISO' file.

1. Right-click the downloaded installer image and choose copy.
2. Select alocation on the USB drive, right-click, and choose paste.
3. When the file copy is completed, you can remove the USB drive.

Use a DVD or USB Drive to Start Server

When you start the server, make sure to choose the DVD or USB drive that
contains the installer image as the booting address. Complete these steps to
install the ESXi (hypervisor).

1. Insert the DVD or USB drive into the host physical server.
2. Select the optional booting address during the server startup.

LEGACY BOOT :
(Bu= 02 Deo 003 PCTI RBAID Adapter
Onboard HIC

SDADUDATD-RW Do fuwe

UEFI BOUOT :

UEFI : SCSI Hard Drive

3. Press Enter to continue'.

Helcome to the YMuare ESXi 6.5.0 Installation

YMuware ESXi 6.5.0 installs on most systems but only
systemns on YMuware's Compatibility Guide are supported.

Consult the YMuare Compatibility Guide at:
http://uun . vnuare .con/resources/conpat ibility

Select the operation to perform.
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4. Onthe End User License Agreement (EULA) page, read the EULA, and
press F11 to accept the terms of the EULA and continue.

(ESC) Do not Accept (F11) Accept and Continue

5. Select the disk where you will install the vSphere Hypervisor and press
Enter to continue.

YMuware Virtual disk (npx .vnhbal:CO: TA:LE)

(Esc) Cancel (F1) Details (F5) Refresh (Enter) Continue

6. Select the desired keyboard and press Enter to continue.

US Default

(Esc) Cancel (F9) Back (Enter) Continue

7. Type a root password, retype the password, and press Enter to continue.

Passwords match.

(Esc) Cancel (F9) Back (Enter) Continue

IMPORTANT  Remember this password; you use it again in future steps.
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8. Press F11 to Install.

Confirm Install

The installer is configured to ESXi 6.5.0 on:
npx .vnhbaB :CO:TO:LO.

Harning: This disk will be repartitioned.

_F1 mmstat

9. Remove the DVD or USB device and press Enter to shut down and
restart. The server shutdown takes a few minutes.

Installation Complete
ESXi 6.5.0 has been installed successfully.
ESXi 6.5.0 will operate in evaluvation mode for 60 days.
To vuse ESXi 6.5.0 after the evalvation period, you must
register for a YMuare product license.
To administer your server, navigate to the server’s

hostname or IP address from your web brouser or use the
Direct Control User Interface.

Reboot the server to start using ESXi 6.5.0.

[EEp ]

Assign an IP Address to the Host

You must assign an IP address to the host so that it is on the desired network
and can communicate with the client workstations. For example, you can
deploy a virtual image template in this server remotely from another
workstation on the same network.

=, Forthe displays in this section, use the arrow keys on your keyboard to move
&)  between the fields on the pages.

1. After the system restarts, press F2 to Customize System/View Logs.
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2. Enter the Login name and password that was created in Use a DVD or
USB Drive to Start Server.
Authent ication Required
Enter an authorized login name and password for
localhost .System.PlantPhAx. local .
Conf igured Keyboard (US Default)
Login MName: [ root 1
Passuord: [ sesesesescrcacne_ 1
<Enter> DK| <Esc> Cancel
3. Select 'Configure Management: Network.'
Systen Custonization Conf igure Management Netuork
Conf igure Password Hostnane :
Conf igure Lockdoun Mode localhost
TPv4 Address:
Restart Management Network 172.18.1.13
Test Management Netuork
Netuork Restore Options Netuwork identity acquired from DHCP server 172.18.1.10
Conf igure Keyboard IPv6 Addresses:
Troubleshooting Options feBB: :250:56¢F :feb2:34d6/64
Vieu System Logs To view or modify this host’s management network settings in
detail, press <{Emter>.
Vieu Support Information
Reset System Conf iguration
<Esc> Log Out
VMuare ESXi 6.5.8 (VMKernel Release Build 5969303)
4. Select 'TPv4 Configuration.’
Configure Managenent Netuork IPv4 Conf igurat fon
Netuork Adapters Automat ic
VLAN (optional)
IPv4 Address: 172.18.1.13
fiPud Configuration | Subnet Mask: 255.255.255.0
Pub Cont igurat ion Default Gateway: 172.18.1.1
DNS Conf iguration
Custon DNS Suffixes This host can obtain an IPv4 address and other networking
paraneters avutomatically if your network includes a DHCP
server. If not, ask your network administrator for the
appropriate settings.
<Up/Doun> Select | <Enter> Change <Esc> Exit
VYMuare ESXi 6.5.0 (VMKernel Release Build 5969303)

5. Select 'Set static IP address and network configuration' and press the
Space bar. (The presence of a small circle between the parentheses
indicates that this option is selected.) Select the IP address, Subnet Mask,
and default gateway address and enter the appropriate values for your
system and organlzatlon.

IPv4 Configuration

This host can obtain network settings automatically if your network
includes a DHCP server. If it does not, the following settings must be
specified:

( ) Disable IPv4 configuration for management network

Use dynamic IPv4 address and network configuration

I(u) Set static IPv4 address and network configuration:

IPv4 Address [ 172.18.1.13 1
Subnet Mask [ 255.255.255.0 1
Default Gateway [ 172.18.1.1 1
<Up/Doun> Select <Space> Mark Selected <Enter> DK [{Esc> Cancel
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6. On the Configuration Management Network page, press <Esc> to Exit. A
message appears to confirm that you want to change the management
network of the host. Select Yes.

Conf igure Management Network: Confirm

You have made changes to the host s management network.

Applying these changes may result in a brief network outage,
disconnect remote management software and affect running virtval
machines. In case IPvb has been enabled or disabled this will
restart your host.

Apply changes and restart management network?

<¥> Yes | <N> NHo <{Esc> Cancel

7. On the System Customization screen, press <Esc> to log out. You have
assigned an IP address to the host server.

Using a vSphere Web Client 1. Open aweb browser and type the IP address that you created for the
hypervisor host. A security warning appears the first time that you
connect to the ESXi host server.

© NewTab X ‘+ L:ifﬂllll
¢ @ o =

~
<

Q Search the Web 2 |=

-

2. Select Advanced.

iy Insecure Cannection X | + == -
<« c @ @ https/172.18.1.13 LU - B+ 4 I o =

% Your connection is not secure

The owner of 172.18.1.13 has configured their website improperly. To protect your information from being stolen,
Firefox has not connected to this website.

Learn more...

Report errors like this to help Mozilla identify and block malicious sites
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3. The security warning expands with an invalid certificate message. Select
Add Exception.

172.18.1.13 uses an invalid security certificate.

The certificate is not trusted because the issuer certificate is unknown.
The server might not be sending the appropriate intermediate certificates.
An additional root certificate may need to be imported

Error code: SEC_ ERROR_UNKNOWN_ISSUER

Add Exception...

N I g R . T e N =V AP

4. Contactyour IT department if you want a security certificate for your
ESXi host server. To ignore the warning, select Confirm Security
Exception.

. You are about to override how Firefox identifies this site,
ey
A Legitimate banks, stores, and other public sites will not ask you to do this.

Server

(f1e 0 Wl hitps://172.18.1.13, | Get Certificate

Certificate Status

This site attempts to identify itself with invalid information.
Unknown Identity

The certificate is not trusted because it hasn't been verified as issued by a trusted authority using
a secure signature,

[] Permanently store this exception

| LConfirm Security Exception |

Cancel |

5. Login to the VMware ESXi Host using the credentials created in Use a
DVD or USB Drive to Start Server. (The default user name is ‘root’.)

6. Select Navigator.

Vroed1b2 - VMware ESXi

(— = CLfer | ® & https//172.18.1.13/ui/#/host

(-} Manage with vCenter Server | 51 Create/Reaister VM | Shutdown [Bg Reb;

Vrtx01b2

Version: §.5.0 Update 1 (Build 6765664)
State: Normal

Uptime: 14.81 days
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7. Select Manage, Licensing, Actions, and Assign License.

i R

“)= C & @ & https/172.18.1.13/ui/#host/manageylicensing = @ nao =

vmware Esxi OGIT218113 + | Holp= |

System  Hardware | Licensing | Packages  Senices  Securiy & users

J& hssign license gl Remces license | (¥ Rekresh '

VMware vSphere & Standard

.
ﬂmdu % Remove icense
Features:

8. Enter the license key and Check Licenses.

_&mm

4 Licanse key I O A0 KO0 00 I

| Check bcense I Cancel

9. Select Assign License. After it is assigned, a list of features that are
associated with the license is displayed.

A License ey [ R e

License key is valld for VMware vSphere 6 Standard

I Assign license I Cancel

Licensing Phiges Servced Secunty & uses

S8 maaign canss g Remove icense | O Retwsh | Actions

VMware vEphere & Standard
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Notes:

24 Rockwell Automation Publication 9528-UMOOTL-EN-P - August 2023



Chapter 2

Deploy PlantPAx Virtual
Image from OVA file

Deploy PlantPAx Virtual Machines

Distributed control systems are composed of several industry-accepted system
elements. Virtual Image Templates are virtualized system elements, which
contain the software and tools that comprise a specific system element. The
templates are a framework to deploy the necessary system elements for a
PlantPAx® system in a virtual environment conveniently and consistently.

This chapter describes how to deploy PlantPAx image templates to create
virtual machines and how to configure the initial settings when powering up
for the first time.

Avirtual machine acts independently and has its own resource allocation from
the host. You interact with virtual machines as if they are on a dedicated
workstation with their own physical resources.

This section describes the first-time deployment of a PlantPAx virtual image.
The virtual image can be deployed from a purchased USB drive or from a web
download stored locally on a workstation.

7, TIP:If the virtual image template is sourced from a USB drive, we advise you to
&) copy thefiles to your workstation and use the copies to speed the deployment
process.

The workstation would be the same computer where you're using the vSphere
Web Client to connect to the host server.

This deployment procedure is applicable to all PlantPAx virtual templates, and
is required every time a virtual image template is deployed for the first time
into your system.

IMPORTANT  If you plan to deploy a domain controller, it's recommended that the
domain controller is the first element that is deployed in the system.
The PADC template facilitates future activities, such as creating your
own virtual image templates and deploying virtual images to your
system at your convenience.
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1. Open aweb browser and enter the IP address that you created for the
host server. Enter the user name and password for the EXSi host, and
Select Log in

Login - Vhware ESXi x ‘ “ =g |

< c @ | © R hitps;/172.18.1.13uif#/login L+ In @ =

User name

—
ot LSS

2. Inthe Navigator pane, select Virtual Machines and choose
Create/Register VM.

Veb01b2 - ViMware ESXi x ‘ e M

<« G @ ® & httpsy/172.18.1.13/uif#/host/vms w N @ | =

vmware ESXi” roo@172181.12 v | Help~ | (CELoCH

‘ “1% Navigator || %) Vrtx01b2 - Virtual Machines

+ [ Host
Manage 1 Create /Registervh | Zonsole ourer or Power off suspend | G Refresh |

Monitor s

B . e ~ St.. v Usedspace ~ | GuestOS ~  Hostname ~ HostC..~ | Host.. ~ Aut.
i virtual Machines YR

H storage [ No virtual machines

@ Networking Ho items to display

Recent tasks

3. Select ‘Deploy a virtual machine from an OVF or OVA file’.

1 New virtual machine

- (EEITITIER  Select creation type

2 Select OVF and VNIDK files How would you like to create a Virtual Machine?
3 Select storage

4 License agreements

% This option guides you through the process of creating
5 Create a new virtual machine
5 Deployment options avirtual machine frem an OVF and VMOK files.
6 Additional settings Deploy avirtual machine from an OVF or OVA file
7 Ready to complete

Register an existing virtual machine

vmware

Back l Next | Finish Cancel ‘A
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4. Enter a name for the virtual machine.
Click in the shaded area and select the .ova file to be used.
The virtual file displays with the name.

%31 New virtual machine - PlantPAx PASS Virtual Template 4.6 VL

+ 1 Select creation type Select OVF and VMDK files

Z SRR LA Selactthe OVF and VMDK filas or OVA for the VM you wauld like to deploy

3 Select storage
4 License agreements

Enter a name for the virtual machine.

5 Deployment options I‘ |
6 Additional setfings PlantPAx PASS Virtual Template 4.6 VL |
7 Ready to complete Wirtual machine names can contain up to 80 characters and they must be unique within each ESXi instance

| * @@ PlantPAx PASS Virtual Template 4.6 VL.ova |

| Back ]l[ Next || Fnish | [ cancel

5. Select the datastore for your configuration and disk files storage..

‘@ New virtual machine - PlantPAx PASS Virtual Template 4.5 VL

+ 1 Select creation type Select storage
+ 2 Select OVF and VMDK files

0 socisionse ]
4 License agreements
5 Deployment options
6 Additional settings

Select the datastore in which to store the configuration and disk files

The following datastores are accessible from the destination resource that you selected. Select the destination
datastore for the virtual machine configuration files and all of the virtual disks

7 Ready to complete Mame ~ | Capacity ~ Free ~ | Type v | Thinpr. w | Access
| Vrtx-Storage1 262TB 1127TB VMFS6 Supported  Single
1items

Back || Next | Finish Cancal \4

IMPORTANT  There are two main formats for storing virtual images: OVF (open
virtual format) and OVA (open virtual appliance). Our templates are
for appliances, which are self-contained virtual system elements.
VMware software labels the wizard ‘OVF Template’ but ignore
because your PlantPAx Virtual Image Templates in the OVA format
are suitable for this procedure.

6. Use defaults for network mapping and disk provisioning, and select
‘Power on automatically.’

1 New virtual machine - PlantPAx PASS Virtual Template 4.6 VL

¥ 1 Select creation type Deployment options

¥ 2 Select OVF and VMDK files Select deployment options

+ 3 Select storage

k4 4 Deployment options

5 Ready to complete

Network mappings |VM Network

VI Network v |

Disk provisioning -ijJThigk
Power on automatically E

Back |h Next Jl Finish Cancel
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7. Select Finish to upload the virtual template.

1 New virtual machine - PlantPAx PASS Virtual Template 4.6 VL

+ 1 Select creation type Ready to complete
+ 2 Select OVF and VMDK files
+ 3 Select storage

+ 4 Deployment options

BT < Ready to complete Product PlantPAx PASS Virtual Template 4 6 VL

Review your seftings selection before finishing the wizard

WM Name PlantPAx PASS Virtual Template 4.6 VL

Disks PlantPAx_PASS_Virtual_Template_4 §_VL-disk1.vmdk
Datastore Vrix-Storage

Provisioning type Thin

Metwork mappings WM Network: VM Network

Guest OS5 Name Microsoft Windows Server 2012 (64-bit)

' Do not refresh your browser while this VM is being deployed.
a0

| Back || wen

Finish ]l[ Cancel |

P

The completion percentage is shown at the bottom.

ik Bt Yom Higlon Bockmurks Tooh Help =1 - |
N2 - WWbware ESG x =
e @& by P host @ nmo =

£ MostVaded (@ Geltrg Sated 8 Webcome ko Vihware v...
vmware ESXi

(3 ManagewmCanter Saner | T CreateRiagistar v | {3 Stutcown [ Reboct | F Rafesn | £ Actions FREE: 337 G4
Vb2 5 5 EasaciTy 238y
verson 650 Updace 1 (Bukd STES664)

S Hermal {coanecie 1 vCarier Server at 172 101 0} —
Uptie: 460 dayn SED EAPAEITY 352 3B

{ FAEE- 43 83 50

=REE 1137R

CARWSITY 182 TH

D o e runsng Dol Cuslomizod image ESX 8.5 Upsste 1 wrBsasa)

@ Mishostin Canine Sarvas Aznons may ¥ wCantar Sarvnr wissat your kncwiadge. £ Actions

~ Configuration
Batlinc Image profs DOIEUC S5 51785564404 (D)
Puwerldge M0 (VRTS) VR HA sl ot configuea
g~ 10 CFUs X Inl{RY NondRt CPU E8-2040 + ihioten Supgarted
@ 2400Hs
. ooy sxorc8 = Srstom information

» [ Vot s FproeTm— Dstatima an nast Mandsy, doty 07, 3090, 12331 LT

@ = Install gate Saurizay November 11 2017, 17.80.58
[T
Hosame e Mty Unknown
P a5 ARC R ETRR ] Senece lag Unkngwn

s - Twgu - - St . Reaula | Complesd v

Iompet Ve L . eTezsemeTiier  avenTenTMA

Ushead - P P PSS e , tava 2 =1 &

Raceedg Vit i Pacas e i U " * £ D Faitec . The spaation is nat sz

PRS- " S L Yo———

The Result column shows ‘Completed successfully’ when the template
upload finishes.

Recent tasks

Target ~ Task ~ | Initiator ~ Queued ~ Started ~ | Result a v Completed v ~
(& PlantPax PASS Virtusl Te... | Upload disk- Plant PAx_PASS_Virt... | root 0710212018 12:44:41 | 070272018 12:44:41 | & Completed successiutiy 070272018 12:50:27
Hone Dawnload VMXCanfig VC Internal 07/02/2018 07:39:13 | 070272018 07:39:13 | @ Complated sucozsstully 0T0Z/2018 07:39:13
(& PlantPAx PASS Virus| Te... | Reconfig VM VC Intemal 0710212018 07:39:13 | 070272012 07:38:13 | & Completed succassiutly 07022012 07:38:13
None Downlosd VMXCanfig VC Internal 07/02/2018 07:39:03 | 070272018 07:39:03 | @ Complated succassiully 070272018 07:39:03
Resources Import VApp oot 0710212018 07:33:02 070272012 07:33.02 | & Completed sucoassiutly 0F22012 07:38:54
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Power On the Virtual Machine

1. Open aweb browser and enter the IP address that you created for the
host server. Enter the user name and password for the EXSi host, and
Select Log in

Logiin - VMware ESXi ¢ ‘ + [= ==

&« ¢ o | @ & https;//172.18.1.13/ui/#/login o O W o =2

vmware ESXi’

Password

e

2. Right-click the Virtual Machine and choose Power>Power on.

Vrbd1b2 - VMware ESXi X ‘ A

@ . httpsy//172.18.1.134

vmware ESXi

&¢ Power [+ Poweron

@ Guest0s

Managi

Moraa {iz» Snapshots

= [ Console
~ 51 Virtual

Moy 53 Upgrade VM Compatibility
Mo

B Storagy
€3 Networ

ig Export

Mware Tools is not ins
aceful shutdown, reb

(i Edit settings

&, Permissions

Edit notes
E tasks
] Rename

X Config

IMPORTANT  When powering on the virtual machine for the first time, the screen
can remain black for several minutes.

Windows Out of Box Experience

The Windows® Out of Box Experience (OOBE) consists of displays that require
customers to accept the End Users license agreement (EuLA), connect to the
internet, log in with or sign up for a Microsoft® Account, and share
information with the OEM.
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Complete these steps for the initial configuration of all virtual machines that
were deployed using PlantPAx image templates.

Windows server 2019 virtual machines require the OOBE following
initialization:
1. Choose the appropriate location, language, and keyboard settings and
Next.
2. Enter the product key to activate windows or choose to activate later.
On the EULA dialog box, read the license terms and Accept.

Type a password for Administrator, retype the password to verify, and
Finish.

Windows 10 LTSC virtual machines require the following OOBE initialization:

Click ‘Skip for now’” for an internet connection.

On the EULA dialog box, read the license terms and Accept.

Type a user name and Next

Create a password, retype password to verify, and Finish.

Create security questions, and Next.

Click No when prompted to make Cortana your personal assistant.
Turn off all privacy settings for your device and Accept.

Enter the Windows product key.

© N &V pHw o Dd e

Initial Windows Login

Alogon message appears, which prompts you to press Ctrl + Alt + Delete key
combination to unlock'.
1. DO NOT press Ctrl + Alt + Delete for a virtual machine.

2. Instead press Ctrl + Alt + Insert. this is the VMware key combination to
unlock.

3. Type the Administrator password that you created and Press Enter.

If you see the Other-User logon, type 'Administrator’, type the administrator
password that you created and Press Enter. Wait until you see the network
message in the following steps.

1. Select 'Yes' to allow the PC to be discoverable.

Networks

1= PlantPaciocal

If you skipped the product key earlier, another dialog window appears to
remind you that Windows must be activated.

2. Inthe Product Key window, enter a valid Windows Product Key.
3. Verify that the product key is correct.
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4. Select OK in the message window when the product key was installed

successfully.

5. Select OK in the activation window.

Activate the key with a KMS server; your company’s or Microsoft’s. See
Appendix A for more licensing information.

VMware Tools

The VMware vSphere Client software has better graphic performance with the
VMware Tools SVGA driver installed. The VMware Tools package also supports
required shared folders and drag-and-drop features.

Other tools in the package support synchronization of time in the guest
operating system, copy and paste between guest and host, and improved
mouse performance in some guest operating systems.

Complete these steps to install or upgrade VMware tools on the VMware

Virtual Machine.

IMPORTANT  Images that are shown in this section are VMware vSphere software,

version 6.5.

1. Open a web browser and type the IP address that you created for the

host server.

2. Enter the user name and password for the local host, and click Log in.

3. From the Navigator in the left pane, right-click the virtual machine in
which you want to update or install VMware Tools. Select Guest OS and
choose Install VMware Tools.

IMPORTANT  The guest OS of the virtual machine must be running.

“T.'; Navigator

~ [ Host
Manage

Monitor

- (51 Virtual Machines

Monitor
More VMs...

E storage
€3 Networking

@ 8 https://172.18.1.13/ui/#/host/vms/172

E1 PASS (1)

| Power

0
Lgh Snapshots
[ Console

g Autostart

(i Edit settings

£ Parmizcinne

E& Install VMware Tools |

-

ic nat inctallad in thic virtual mas

4. Open Windows Explorer on the virtual machine image that you want to

install VMware Tools.
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5. Select ‘This PC’ to view the tools to install on Drive D.

SOl em- This PC [= =[]
Computer e ) 0
® — |;l__i » ThisPC » v c,| [ Search This PC o]
4750 Favorites 4 Folders (6)
.@sk‘top 3
& Downloads E Desktop ]— & Documents
15| Recent places .
278 This PC }Q Downloads } ) Music
I | pg Desktop
I || Documents t Pictures ! Videos
I | @ Downloads
b1 Music 4 Devices and drives (2)
I | = Pict:
; fc LIEES am Local Disk (C:) g DVD Drive (D:) VMware Tools
b | B Videos " I | 0 bytes free of 77.7 MB
b &, Local Disk () S 354 GE free of 596 GE _ CDFS
1 [ DVD Drive (D:) Viw
D&i MNetwork
Biterns ==

6. Double-click the DVD drive to initiate the install.

7. When the VMware Tools Setup Welcome window appears, select Next
to start the setup wizard.

Display Action
Choose Setup Type Select Complete
Ready to Install VMware Tools Select Install
Completed VMware Tools Setup Wizard Select Finish
VMware Tools Setup Restart Select YES

If you are using the free version of VMware ESXi hypervisor, which doesn't
include a vCenter server, then you can skip chapter 3 and proceed to chapter 4
to continue with Windows server configuration.
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Install a vCenter Server

VMware ESXi vCenter Server

A VMware vCenter server is an optional component that allows for centralized
management of your virtual infrastructure. You can manage multiple hosts
servers and access all VMs from one vSphere Web Client.

While a vCenter server may not be needed with small systems, it is highly
recommended and required with large systems. Following are some of the key
features that a vCenter server provides:

Single sign-in authentication (Domain controller required)

Access multiple hosts, all VMs, datastores, and networks from one
console

Organize inventory objects such as hosts, folders, and clusters into
datacenters

Create templates for future virtual machine deployments
Clone existing VMs, even when powered on
Migrate VMs between hosts and datastores

View alerts and notifications that are required to help prevent or remedy
the emerging issues

IMPORTANT A vCenter server can contain multiple datacenters. Larger
organizations can use multiple datacenters to represent
organizational units in their enterprise. Inventory objects can
interact within datacenters, but interaction across datacenters is
limited. For example, you can move a virtual machine with vMotion
technology across hosts within a DataCenter but not to a host in
another DataCenter.

There are two installation types for a vCenter server.

vCenter Server for Windows® software runs on a Microsoft® Windows
server operating system. This Windows OS can run on a physical
computer or as a virtual machine on a host server.

vCenter Server Appliance (vCSA) runs as a virtual machine based on
SUSE Linux Enterprise Server 64 bit and comes as an OVF appliance
ready for use.

There are differences in scalability (number of hosts and VMs), database
options, performance, and security in each vCenter server type. Determine
which option best fits your environment before implementing a vCenter server
for infrastructure. This section shows how to install a vCenter Server
Appliance.

Perform these steps on the workstation that you use to manage your virtual
appliances (templates and machines).

Rockwell Automation Publication 9528-UMOO1L-EN-P - August 2023 33



Chapter 3 VMware ESXi vCenter Server
1. Onthe VMware website, download the vCenter Server Appliance 6.5
software and mount the .iso image.
2. Start the vCenter Server Appliance 6.5 installer. Choose vCenter Server
6.5 appliance>vcsa-ui-installer>win32>installer.exe.
6{;;1 v Computer » Local Dink (C:) # Wemnber Sorvnr 6.5 sppliance » vees-oi-imtaller ¢ windl o
Organce = Inchode in Sbaary = Sk with = Bumn e Ecider
o Favonter :
b ocales
il Libranes b swscurce.
ik, image_rmousces, 200, paecent pak
W Cemputer conbent_nesources M) parcert pak
Corbent_phetll gk
Nl Hrtwork 5 dbscompder 4100
& Hmpegdl
ataschtl dat
e BHEGL.M
% BbGLESv .40
LKINGL
B UKCENSE S ctoemaum it
e blob be
o Fde. S
snapibet_blok b
w_psescurcei_200_percent pak
::::-mn_m_pmﬂ.p.t
w wingeat] Lol
3. Select Install. The install wizard opens.
() wCenter Server Appliance Installer =1 @ |[&=
Installer
vm vCenter Server Appliance 6.5 Installer @Englisn
ance or Platform Services Cor er Appliance
o Migrate
Migrate from an existing vCenter Server for Windows to a vLenter Server Appliance
@ Restore
Restore from a previously created vCenter Server Appliance backup
Wizard Page Action
Introduction Select Stage 1. Deploy appliance.
End User License Agreement Check | accept the terms of the license agreement
Select vCenter Server with an Embedded Platform Services
Select Deployment Type Controller

: Enter the ESXi host information of the location where the vCenter
Appliance Deployment Target server appliance is deployed, and enter the host credentials.
Certificate Warning Select YES
Set up appliance VM Enter the name for the appliance and set the root password.
Select deployment size Select the deployment size for your environment.

Select datastore Select the datastore where the VCSA appliance is stored.

) . Configure the networking for the VCSA appliance. Put the IP address
Configure network settings that is used in both the DNS forward and reverse lookup zones.
Ready to complete stage 1 Verify that the configuration is correct on the summary dialog box.
Install Stage 1 Deployment Complete Select continue to proceed to stage 2 setup
Stage 2 Introduction Select Next
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Create a DataCenter

Wizard Page Action
Appliance Configuration Set the Time Synchronization mode. Enable SSH Access.
330 Configuration Enter a domain name, password, and site name.

Configure CEIP

Check to participate in the Customer Experience Improvement

Program (CEIP) if interested.

Ready to complete

Verify that the configuration is correct on the summary dialog box.

A DataCenter is the primary container of inventory objects such as hosts and

virtual machines.

With the creation of the DataCenter, we show you how to make a copy of a
virtual image and turn it into a template for future deployments.

IMPORTANT  The images that are shown in this section are YMware vSphere Client
software, version 6.5.

1. InaWeb Browser, enter the IP address of the computer where your
vCenter Server is installed.

2. Click vSphere Web Client (Flash).

Getting Started

To access vEphere. log in o

£ Client (Flash)

vSphere Client (HTMLS) - partial functionality
For help, see

wentation

ed Functionality in wSphere Client (HTM

L)
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For Administrators

Web-Based Datastore Browser

Use your web browser 1o find and download fles (for
exampile, virtual machine and virtual disk files)

Browse datasiones in e vSpnere inventory

For Developers

viphere Web Services 5DK

Leamn about our latest SDKS. Toolkits, and APis for
managing Viware E3X) and Viiware vCenter, Get
Sample cooe, reference documentation, participate in
our Forum Discussions, and view our labes!t Sessions
and Webinars

Léam more about he

Barvices SOK

Download trusfed root CA centificates

Welcome 1o Viware viphere x |+ I;IE-
|'5_ (iR~} D hitpsy17218.1.8 o nol 2
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3. Enter the Username and Password. Use the User name and password
that you created for the vCenter Server.

(5 vSphere Web Client x ‘ + [- [==

&« c o @ M £ https://172.18.1.8/usphere-dlient/?csp - @ T I @ 8

o VMware*vCenter” Single Sign-On

Password:

IMPORTANT  The user name consists of the vCenter Single Sign-0n user name
plus ‘@' plus the Domain name.

In our example, the user name is
‘administrator@system.plantpax.local.

The DataCenter is the primary container of inventory objects such as hosts and
virtual machines.

4. From The VMware vSphere Web Client dialog box, highlight your
vCenter Server, and click 'Create DataCenter'.

| @ vsonere et e x|+ B

& [CAR) @l & https17218.18/sphere-dient Tesphentensionid%d Dvsphere.oo - @ i mmo £

vmware* vSphare Wab Client ) | AdministratorgEYSTEM PLANTPAX LOCAL = | Help = |
X | (] VRTXvCentersystemplanpaxsocal | T ] YA o | fohAdsons -
Geltin_ | Sum.. Monftor Confl. Permi. Dalac. Hosts. VME Datas.. .. Linke. Eden. Updal.

L
Whal iss wCemter Server?

vCenter Senver allows you 1o manage

mulliphe EEXNESX hasts and the vitual

machines on them Becnse these

emwronments can grow very large. vCanter

Server provides usehul management taols

llke e ability to organize the nosts and vrfual

machines into clusters with viphers DRS

and w3phere MA Multiple vCerter Server e

spstorms can be managud by the vSphens

Web Chenl 50 that thewr indmdual inventones f

can be presented and managed under ang o dlmas

“pane of giass” .
Ay wCenter Server systens fof which you <. '
have prwileges and hat have been registered Pl St

with the Lookup Senice, or added manually
with the wCenter Reqlsiration Teol in the
Adminiztration section, will appear in your
imaentory 1o B lef

i

Basic Tasks Explore Further

"7 Create a folder Learn more about folders

Learn about datacenters
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5. When prompted, type a name for the new DataCenter (‘New DataCenter’

in our example) and click OK.

New Datacenter

2 »

Datacenter name: ||New Datacenter I

Location:

() VRTXvCenter.system....

Add a Host

The host is the physical server where the virtual image is to be deployed.
1. The New DataCenter is added under the vCenter Server. Highlight the

New DataCenter and select 'Add a Host' to add a host server. The add

host wizard starts.

J () vSphere Vieh Client X |+_.;

}(— c @ G R s

vmware: vSphere Web Client A=

o ) 2 &
- [ZIVRTHvCenter. system. Whatis 7
Adatacinler is lhe primary cantaines of
inventory obgects Such ag hosts andwrtueal
machines From the datacenter, you can add
ang arganie imventory objacls. Typlcally, you
add hosts, folders, and clusters 1o 8
datacenter

wCenter Senver can confain muitiple
daticenters. Lirge comganies mighl use
multiple datacenters o regresent
DrGAREaRonal UNs in their enterpnse.

Basic Tasks

f Add a host

i} Create a cluster

¥ Create a new virtual machine
£ Add a datastore

&2 Create a distributed switch

AN T2A8.1 8 vsphere- dhent flospextensic

.o

vangater K| Cynewoanacener | 4] %3 89 5 T @actons -

4 Back Gefting Sto_ | Summary  Monilor  Coefigure  Permissions  Hosls &Gl WMs  Dalastares

Explhone: Further

Learn more about datacenters
Learn how to create datacenters
Learn about hosts

Learn about clusters

Learn about folders

 EsaIBCIG Ul pony, ()

Wizard Page

Action

Name and Location

Enter the Host IP address

Connection Settings

Enter the Username and Password

Host Summary

Verify the settings

Rockwell Automation Publication 9528-UMOOTL-EN-P - August 2023

37



Chapter 3 VMware ESXi vCenter Server

Wizard Page Action

« If you use the trial license that came with the VMware vSphere Hypervisor, select the default Evaluation License
« If you have purchased a permanent license, Select the Plus Sign to assign a new license key to this host. Enter the license key.

T rr— < I T=T=lE
]
= > & @ DM B P TR IE B ’ . 3 D o @ mo =

1 Mame amd cason

é °.‘ ;)

LSl - 2 comecton setings

3 Host summany

| Cor— T Ot

5 Lockiown mode.

Assign a license

T Rovasty t complet

Ansigamest Valduson tor Licasss 1

« Tha boanse assignmant is vakd

Lockdown Mode Select Disabled

Select the DataCenter that you created.

VM location IMPORTANT: Because a vCenter server can manage multiple host servers, make sure to create/select the proper DataCenter and host server where the
virtual machines reside.
These organizational features help improve your understanding of your infrastructure and help with the management of servers.
Ready to complete Verify that the configuration is correct.
2. The Host is added under the DataCenter. The Navigator section of the
vSphere Web Client window now includes the vCenter server

(VRTXvCenter), the DataCenter (New DataCenter), and the Host

(172.18.1.13) as shown in the following image.

(5 vSphere Weh Client X | + u_-' =l
<« ¢ @ @ i hitps://172.18.1.8/vsphere-client/Tcsp#extensionld%3Dvs - Q9 I @ =
vmware- vSphere Web Client  #= U | Administralor@SYSTEM PLANTPAXLOCAL » | Help + Q Search
~ Navigator p § ‘7 [ 17218413 " B B U, L- Eg \{é}AmonSv =
: 4 Back e J Getting Sta... | Summary Moniter  Configure  Permissions  WMs  Resource. Datastores Metworks ~ Update Ma..
v |2 8 8 Y5
| [ VRTXvCenter.system.plantpz Whatis a Host?

[l New Datacenter Ahostis a computer that uses virtualization Virtual Machines
<‘ snﬂv:]are, EL}fh ‘as ESXdantiE%)gﬁn rudn virtual
zz:nérrl;rsesuuuicseg[lil\gt\:nu; macgnwes use
and give virtual machines access to storage L
and netwark connectivity. Chestel
Host
Datacenter
vCenter Server
vSphere Client
38
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Create a Template

This section shows how to create your own templates. These templates can be
based off the original PlantPAx® virtual image template and customized into

your own templates.

Start with an existing virtual machine. This VM may receive changes such as
additional software, security patches, and configurations that you plan on
reusing throughout your infrastructure. When you are finished modifying the

VM, it is cloned, and a template is created.

To help prevent VMs from containing duplicate system identifiers, it is

recommended to run Windows SYSPREP on the operating system before

creating a template.

This template can be used to deploy other images. You can store the original
template for safekeeping in case you modify your templates.

1. Right-click the virtual image that you want to clone and choose
Clone>Clone to Template to open the wizard.

(%) vSphere Web Client x ‘ aF

[ = (&)

\WE =RV o 1T { 5, Actions - PlantPAx PASS

Navigator
4 Back

g

@ @ H £ https://172.18.1.8/vsphere-client/?csp#extensionld%3Dvsphere.core.v:

Power y

Guest0s y i a8 &
Snapshots

B & Open Consale

~ [ZIVRTXvCenter.syste (33 Migrate... ine?

[t New Datacente (TS TN ::~: Cione to Virtual Machine

~ @ 17218143 Template

& PlaniPax

Fault Tolerance
VM Policies »
achine is an isolated
» , You can use virtual
rworkstation
g environments, or to
feations

Compatioility
Export System Logs.

By EditResource Settings
5 EditSetiings

Imachines run on
ame host can run
fove To.

Rename

Edit Notes

Tags & Custom Attributes »

* [25 Cione to Template.

» @ Clone to Template in Library
. B —

* iy Monitor Configure Permissions Snapshots Datastores  Networks Update Manager

- O mn @ =

U | Administrator@SYSTEM.PLANTPAXLOCAL ~ | Help =

ssalfioid upiIop, (0) s,

Virtual Machines

Wizard Page

Action

Select a name and folder

Enter a name for the new template and select a location

Select a compute resource

Select a host location to store the new template

Select storage

Select the disk format, storage policy, and the hypervisor that manages the resources of the server that hosts this template.

Disk Format Options:

« Same format as source - Use the same format as the original disks.

device are formatted with zeros to overwrite any older data.
« Thin Provision - Disk storage is allocated on demand as data is written to virtual disks.

Thick Provision Lazy Zeroed - Disk storage is allocated immediately in a default thick format. Blocks containing older data on the
storage device are cleared only when the virtual machine writes new data to the disk for the first time.
Thick Provision Eager Zeroed - Disk storage is allocated immediately in a default thick format where blocks on the physical storage

Ready to complete

Verify that the configuration is correct.
IMPORTANT: The process of cloning a virtual machine to a template can take up to 30 minutes. This time is largely dependent on the

size of the hard disk drive of the virtual machine you are making a template from.

e )
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TIP: Consider the clone to virtual machine option as a manual method to back up
fully configured and running virtual machines. The cloned image can be stored
on a local or remote VMF5 datastore, or a remote datastore on a Windows server

featuring network file storage (NFS) capability.

39



Chapter 3 VMware ESXi vCenter Server

Deploy Your Own Template When you have virtual image templates that are loaded into your DataCenter,
you can deploy any number of virtual images from those templates. Additional
deployments can be performed from these new templates.

1. InaWeb Browser, enter the IP address of the computer where your
vCenter Server is installed.

2. Click vSphere Web Client (Flash).

X Welcome 1 ¥hware viphere x |+ I;IE-
I @ B hrtpsy172181.8 o @ i no £

Getting Started For Administrators.
To access vaphere. log in 1o ‘Web-Based Datastore Browser
s o v st 2 o e
wSphere Client (HTMLS) - partial functionality - example, virtual machine and virual disk files)
For help, see & e oo Browse datasiores in the vBphere inventony

For Developers

M umentation t h& P X -
Supported Functionality in vSphere Client (HTMLS) , ,H:‘k r vSphere Web Services SDK
5 4 ] g Leam about cur latest SOKs. Toolkits. and APis for

managing Viware E3X) and Viiware vCenter, Get
sample coge, reference documentation, participate in
our Forum Discussions, and view our labes!t Sessions
and Webinars

Leamn more about the Web Senices 30K

Browse objetls managed by vSphere

Browse viphere REST APls

Download trusfed root CA centificates

3. Enter the Username and Password. Use the User name and password
that you created for the vCenter Server.

(&) vSphere Web Client X ‘ + L-ﬂ-
<« c @ @ M R https://172.18.1.8/vsphere-dlient/?csp - 0w i @ .=0

s ok VMware"vCenter” Single Sign-On

Password:

IMPORTANT  The user name consists of the vCenter Single Sign-0n user name
plus ‘@' plus the Domain name.

In our example, the user name is
‘administrator@system.plantpax.local.

4. From the left side of the vSphere Web Client window, highlight your
vCenter Server, then select the 'VMs' tab. Select the 'VM Templates in
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Folders' tab, then right-click the template that you plan to deploy to a

New Virtual Image. Select 'New VM from This Template'.

1721818/ vsphere-cop

4]

Baaans | B o [ 0 B @hdom

Gefting Stat.  Summary Montor  Configure  Fermissions ERHWP

= [ VRTICenter system planipariocal |+ | |Vl Machines WM Tompiates in Felgers | vapps

| ~ Jig ke Dthchnkdt FENew Mt A8 Comentn . 3P Clonein T 4 Cloneio T | {F Acions « B (a Fne -
%M TTASS nama l_.trmmn:m Dot 05 Companbilty
13 How Tompiate J vicas e Tidgits ESK 5.0 300 ater (VM s
'l 2% New VM from This Tempeals |
Cormvert lo Virhual Wachine,
§7 Cloneto Tamgpilate
#y Clone to Libeary.

| Move To.
Rename.

| Tags & Custom Afributes 3

| AgdPermission.

R from I rdory
| Dateta from Cuzke

Al vCenbed Drchestralor plugen ACions  »

M Upaate Manager wl 1 Objects |3 Export (3 Copy =

5. Inthe Name box, type a name for the virtual machine. In the Inventory

Location box, select a location to store the new virtual machine.

£% New Template - Deploy From Template

2 »

Select a name and folder

1 Edit settings
Specify a unique name and target location

1a Select a name and folder

1b Select a compute resource Enter a name for the virtual machine.

¢ Select storage |New Virtual Machine |

1d Select clone options Virtual machine names can contain up to 80 characters and they must be unigue within each vCenter Server VI folder,

2 Ready to complete Select a location for the virtual machine.

L Q Search :|

Select a datacenter or VM folder to create the new virtual
machine in

Back Finish || Cancel |

0
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6. The 'Select storage’ step appears.

« Inthe 'Select virtual disk format' box, select "Thin Provision'.
+ Inthe 'VM storage policy" box, select 'Datastore Default'.

« Select the Datastore to host the cloned template.

#% New Template - Deploy From Template 7 "

1 Edit settings Select storage

Select the datastore in which to store the configuration and disk files
+  1a Selectaname and folder

~ b Selecta compute resource  gajact yirtual disk format - -]
Select slorz =
¢ o VM storage policy: Datastore Default |~ | @

1d Select clone options

The following are from the destination resource that you selected. Select the destination datastore for the virtual
2 Ready to complete machine configuration files and all of the virtual disks.

Name Capacity Pravisioned Free Type Cluster

[ Vrbx-Storage1 262TB 358TB 851.17 GB VMFS B

Format Description
Same format as source Use the same format as the original disks.
Disk storage is allocated immediately in a default thick format. Blocks
Thick Provision Lazy Zeroed containing older data on the storage device are cleared only when the virtual

machine writes new data to the disk for the first time.

Disk storage is allocated immediately in a default thick format where blocks

Thick Provision Eager Zeroed on the physical storage device are formatted with zeros to overwrite any
older data.
Thin Provision Disk storage is allocated on demand as data is written to virtual disks.

7. The 'Select clone options' step appears.

« Clear 'Customize the operating system'. We recommend that no
Customization is done at this stage.

« Clear 'Customize this virtual machine's hardware (Experimental)'.
« Clear 'Power on virtual machine after creation'.

£F New Template - Deploy From Template 7) M

1 Edit settings Select clone options

Selectfurther clone options
~  1a Selectaname and folder

~  1b Selecta compute resource Custamize the operating system
v 1c Select storage

v 1d Select clone options

2 Ready to complete

Customize this virtual machine’s hardware (Experimental)

Power on virtual machine after creation

Back Cancel

IMPORTANT  When you clone a virtual machine or deploy a virtual machine from
a template, you can customize the guest operating system of the
virtual machine. Customizing guest operating systems can help
prevent conflicts if virtual machines with identical settings are
deployed.

You can specify the customization settings when you launch the
Guest Customization wizard during the cloning or deployment
process
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8. The Ready to Complete' step appears. Select one of the following to verify
settings:

« Ifthereis incorrect information, click Back to correct the information.

« Ifthe information is correct, click Finish.

IMPORTANT  The process of deploying a virtual machine from a template can
take up to 30 minutes. The time that is required is largely dependent
on the size of the hard disk drive of the template you are using to
deploy a virtual machine.

9. You can view the status of the task by finding 'Clone virtual machine' in Recent
Tasks at the bottom of the window. When the status = Completed, the cloning

is finished.
Optional Virtual Machine To help expedite the use of your virtual machines, consider the following
Interactions options:

. Initiate Automatic Startup on page 43
« Set Resource Pool Priority on page 47

Initiate Automatic Startup

1. InaWeb Browser, enter the IP address of the computer where your
vCenter Server is installed. This IP address was created in Assign an IP

Address to the Host.
2. On the Welcome to VMware vSphere screen, click vSphere Web Client
(Flash).
2 Welcome 10 Viware viphere x |_-§- I;IE-
|"_ [ ~] B hrtpsy17218.1.8 e nol 2

Getting Started For Administrators
To access vEphere, 1og in 1o Web-Based Datastore Browser

i Client (Flash) Use your web browser 1o find and download fles (for

vaphere Client (HTMLS) - partial functionality - example, virtual machine and virual disk files)
For help, see Browse datasiones in he vSphene Inventony

For Developers

viphere Web Services 5DK

Leamn about our latest SDKS. Toolkits, and APis for

managing Viaware ESX) and Viiware vCenter. Get
Sample cooe, reference documentation, participate in
our Forum Discussions, and view our labes!t Sessions
and Webinars

Léam more about the Web Services SDK

Download trusfed root CA centificates
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Lt

3. Enter the Username and Password. Use the User name and password
that you created for the vCenter Server in Install avCenter Server. Click
Login.

(&) vSphere Web Client

< c @

x‘+

(@ M £ httpsy//172.18.1.8/vsphere-client/?csp

VMware*vCenter” Single Sign-On

Iministrator@systam.plantpax.local

User name:

Password:

IMPORTANT  The user name consists of the vCenter Single Sign-0n user name

plus ‘@' plus the Domain name.

In our example, the user name is
‘administrator@system.plantpax.local.

4. Select the Host Server, then select the Configure Tab, then select VM
Startup/Shutdown. On the VM Startup/Shutdown window, click 'Edit'".

T2 181 Bvinhere-dientiospirension|d%A Ovsphene.core host managesettingsy e W o =

J B viphves Wek Cheme x £
e e @ e ey

vmware vSphere Web Client LE L | Aeministralon @S YSTEM FLANTPAXLOCAL = |

(FREEALIRE IS bl | Eacons -
Goling Sl Summary Mrﬂlw!‘ulmaxw VM Resoutce Pools  Dalastores  Hebworks  Updale Manager

§Romior
4 Back
L & a a
« [ WRTGonter sysiem planipaskocal
= [ Morw Distacantar

Wirbesal Machise Startup and Shuldows

- Slorage = e nost s par of avEshere A chuster, e sutomatic Staup and shuldawn of wriual machnes i disstled

Storage Adapiers
tvan VAl Namae Glami  Bieus Daley Saussees Uahaver Srtssen Dalsy )

Massal St
HumVirtual Macking  Cusablod

Slorage Devces

Detasiores 120 Powerof

| Mo Cacte ConBguration PlanPan PASS Desasied 1 Fower o

 *old 4 5 Win 2042 RE A
G New sl Naching Piotocs Ladpoinla
paca | e
S et Vitual sweitches
B PP PASS
'_f: Tes pEEWS Vi ol adppteTe

Paymieal adaprarn

TCPAP configuration
Advnnced

 Virtual Machines

Agent VM Sertngs

B Test2 21.PASE
8 Tes279.500
B Teat2 20ATR

F TP &-ColudG
i Tra-TESTIGR
UM RDEOWE 2
B UNT-ROSOWE-3

Swap T8¢ kcabion
Delaalt Vil Compatbaty
» System
Liceasing
Time Cosligaration
Asthenticalion Services
Cwmhcals

Rockwell Automation Publication 9528-UMOOTL-EN-P - August 2023



Chapter 3

VMware ESXi vCenter Server

5. Check 'Automatically start and stop virtual machines with the system'.
Click the Up Arrow to move the desired Virtual Machine host server from
the Manual Startup category up to the Automatic Startup category.

You can select additional images and click the Up Arrow or Down Arrow
to determine the startup order as shown in the following image. A

sequential number order appears.

D 172.18.1.13: Edit VM Startup and Shutdown

Default VM Settings

System influence Autumalically start and stop the virtual machines with the system

Startup delay second(s) [ Continue immediately if VMware Tools starts.
Shutdown delay second(s)

Shutdown action | Pawer off |-|

Per-VM Overrides

Automatic Startup
Any Order
Manual Startup

Type Order VM Name Startup Behavior  Startup Delay... Vhware Toels Shutdown Behavior Shutdown Action  Shutdown Delay...

I PlaniPAx PASS Use Defaults 120 Continue Use Defaults

Power off 120 I
New Virtual Machine  Use Defaults 120 Continue Use Defaults Paower off 120
[ ok || cance |

6. When you are satisfied with the Startup order, click OK.

E 172.18.1.13: Edit VM Startup and Shutdown

Default VM Settings

Systeminfiuence [ automatically start and stop the virtual machines with the system
Startup delay second(s) || Continue immediately if VMware Tools starts.
Shutdown delay second(s)

Shutdown action | Power off | -|

Per-VM Overrides

Manual Startup

+ 3
Type Order | VM Name Startup Behavior  Startup Delay... VMware Tools Shutdown Behavior Shutdown Adtion  Shutdown Delay.
Automatic Startup

1 PlantPAx PASS Use Defaults 120  Continue Use Defaults Power off 120

2 MNew Virtual Machine  Use Defaults 120 Continue Use Defaults Power off 120 B
Any Order

Cancel
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7. The Virtual Machines are now configured for Automatic Startup as
shown in the following screen capture.

| J (D vighere Web Chent
[(— [l

. =

vmware: vSphere Web Client  #=

4 Dack
v |8 a

» [l N Datacentar
» [ Praneax
v (12 1eaaz

i Teatz 21-8WS
£ Tasb 21HIST
) Test221.0WS
3 Test2 21-PADC
B Teab- 21-PASE
G Teabz 2100

3 Task FNTR

I VRTHCenter. yslem plantpas focal

& *Gold 45 Win 10 1708 A |
& “*Gold 4.5 Win 3012 RI Au. |
B Moew Vimsal Maching
;j;;ACA
Eoane
) PlariPhs PASS
G Tostd H-AppSere WS

DM B hHpsI72181 BNsphere-dRatcpietensonitkaDvaphent.core Nos manageset @ wm =
ETEMPLANTPAXLOCA, = | Help = | 1
B oarzanaas | B bl B | G aaes - iy
] b s
Gatng Stared  Summary  Mon®or  ConSgure  Permessions  VMs  Resource Fools  Datafiones  Networks  Update Manager s
2 E
| Virtual Machine Starhip and Shuldown [Em 7
v Stoiage 1 ie haat e pa of 8 VGpEhars HA SUBIB, e SUIOMENE IR AN Shuldtwn of Wihial Mackines (3 disanied §
oL Adnatary mine Vi s Srann Saamup Datwy Shatsmen Boamam | Butsmen Demy s 7| L= 8
s Dissichn Aartomatic Starmup
Dasbetones 1 PlaniPis PASS Enabied 120 Powerofl 120
lead Cache Configuration 2 Mow Vetua Maching | Enatied W0 Power ofl P
Prodocol Endponts Manual Stanup
+ Hetworking
Virtual swaiches
VMlkainel adaplers
Fysical adagiers

TCPAR configuration
Advanced

« Virtual Machises

Agent VM Settings

Swp file location

DeSanil VM Compalitisty
 System

Licensing

Tima Coafigeration

Authenticabon Services

Carsficatn

IMPORTANT

Following is the recommended startup order for the typical system
elements of a virtual PlantPAx system.

1. Process Automation Domain Controller - PADC

2. SOL server - AppServ-Info (SOL)

3. Process Automation System Server - PASS

4. Engineering Workstation Application Server (AppServ-EWS)
5. Redundant Process Automation System Server - PASS

6. Batch Management Server (AppServ-Batch)

7. Operator Workstation Application Server (AppServ-0WS)

8. Historian server - AppServ-Info (Historian)

10. Asset Management server (AppServ-Asset)

11. Level 3 devices and computers
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Send Commands to Host Server

You can also send shutdown and restart commands directly to the host server
via the vSphere Web Client.

1. On the vSphere Web Client window, right-click a host server and choose
either Shut Down or Reboot.

(%) vSphere Web Client X ‘ aF

< C o

o} ¥ https://172.18.1.8/vsphere-client?csp#extensionld%3Dvs;

U | Administrator@sY;

vmware* vSphere Web Client #=

Navigator X 17218143 | B B [ [y [y | {chActions ~
4 Back i B'.Actiuns—172.13.1.1.3 Zonfigure  Permissions
J | & 8 e New Virtual Machine »
[ VRTxvCenter system plantpax local Mew vApp »
w [{g New Datacenter # New Resource Pool... ion
R 17218113 #j Deploy OVF Template... pua
Connection |
e A
Maintenance Mode » huiel

Certificates »
| Shut Down
Storage » ES Rehoat
#) Add Networking... ——

2. In the confirmation window, type a reason for the Shut Down or Reboot
and click OK or Cancel.

Q 172.18.1.13 - Shut Down Host

(7) [ 172.18.1.13 - Reboot Host

You selected to shut down host 172.18.1.13

Log a reason for this shutdown operation:

You have chosen to reboot host 172.18.1.13

Log a reason for this reboot operation:

Enter a reason herej

Enter a reason herej

This hostis notin maintenance mode.

This hostis notin maintenance mode.
& Shutting down or rebooting a host that is notin maintenance mode will not

& Shutting down or rebooting a hostthat is not in maintenance mode will not
zafely stop the running virtual machines on this host. Ifthe hostis partof a
wSAN cluster, you might lose access to the vSAN data on the host.

FPutthe hostin maintenance mode before you reboot or shut down the host.

zafely stop the running virtual machines on this host. Ifthe hostis partof a
wSAN cluster, you might lose access to the vSAN data on the host.
Putthe hostin maintenance mode before you reboot or shut down the host.

Shut down the selected host?

Rebootthe selected host?

T] Cancel ] oK [CELSILE

Set Resource Pool Priority

You can set the priority of the resource allocation that your virtual machine requires
from the host server. The allocation of CPU and memory resources depends on
performance needs. A virtual machine can be grouped for High Performance, Normal
Performance, or Low Performance depending on its performance needs.

IMPORTANT  For more information and resource pool priority recommendations
for servers and workstation, see Resource Pool Allocation in the
PlantPAx System

Reference Manual, publication PROCES-RMOO1.
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1. InaWeb Browser, enter the IP address of the computer where your
vCenter Server is installed. This IP address was created in Assign an IP

Address to the Host.

2. On the Welcome to VMware vSphere screen, click vSphere Web Client

(Flash).

re——— BE |
N ) @ § netpsy172181.8 - @ n@o =

Getting Started

To access vaphere. log in 1o

vSphere Web Client (Flash)

vaphere Client (HTMLS) - partial functionality

For help, see R

For Administrators

‘Web-Based Datastore Browser

Use your web browser 1o find and download fles (for

exampie, virtual machine and virtual disk files)
Browse datasiores in the vBphere inventony

For Developers

viphere Web Services 5DK

Leamn about our latest SDKS. Toolkits, and APis for

managing Vikware ESX0 and Viware vCenter. Get

’ cumentabion t e
pported Functionality in vSphere Client (HTMLS) ,r )
5

sample coge, reference documentation, participate in
our Forum Discussions, and view our labes!t Sessions
and Webinars

Leamn more about the Web Senices 30K

Browse objetls managed by vSphere

Browse viphere REST APls

Download trusfed root CA centificates

3. Enter the Username and Password. Use the User name and password
that you created for the vCenter Server in Install avCenter Server. Click
Login.

(&) vSphere Web Client X ‘ + L—.ﬁ-

« c @ @ B B hitps;//172.18.1.8/vsphere-client/Tcsp 4 I @ =

s ok VMware"vCenter” Single Sign-On

Password:

IMPORTANT  The user name consists of the vCenter Single Sign-0n user name
plus '@ plus the Domain name.

In our example, the user name is
‘administrator@system.plantpax.local.
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4. Right-click a host server and choose New Resource Pool.

(&) vSphere Web Client x ‘ ae

& ) @ M & https//172.18.1.8/vsphere

vmware* vSphere Web Client f=

X l @172.13.113@. y_»é) U, h_
| [3 Actions - 172.18.1.13 |

i g @ NewVitual Machine 4

= I ew vA) »
- f._-,-.lVRTX\fCenter.system.plantpax.’. g
« [ New Datacenter I@ Mew Resource Poal... I |
¥ Deploy OVF Template...
| & Mew Virtual Machine Connection 8
| [ PlantPAx PASS Maintenance Mode 3

5. Type the priority in the Name text box. For example, High Performance.
From the Shares pull-down menu, select 'High' for the CPU and Memory
Resources categories.

3 172.18.1.13 - New Resource Pool (2) »

Mame: |High Performance |

~ CPU
Shares | High |v|
Reservation 2000 [~ (wz -]

Max reservation: 20,253 MHz

Resenvation type [} Expandable

Limit | Unlimited |v'| [Hz [+

Max limit: 20,253 MHz

~ Memaory
Shares | High |v|
Reservation [ 4096 I~/ (ve  |-]

Max reservation: 59,433 MB

Reservation type [ Expandable

Limit | Unlimited |v'| [mB [~

Max limit: 60,129 MB

6. Repeat step 1 through step 5 for each virtual machine depending if the
priority is High Performance, Normal Performance, or Low
Performance.

The priority types appear in the tree for the host server.
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7. Drag-and-drop virtual machines to the Resource Pool that matches the
needs and intended use. Settings for that resource pool are assigned.

. (&) vSphere Web Client x I
a

OEX-E~

vmware* vSphere Web Client

MHavigator

Back
|| B | 8 a
v@VRTX\fCenter.system.plantpax.local
|+ [l New Datacenter

R 17218113
w (2 High Performance

(11 New Virtual Machine
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Local Administrator User
Accounts

Common Windows Configuration

The PlantPAx® system servers and workstations (virtual machines) are built on
Microsoft® Windows® operating systems that require some basic
configuration.

Windows server 2019 Standard virtual machines are as follows:
« Process Automation Domain Controller - PADC
« Process Automation System Server - PASS
« Process Automation System Server Consolidated - PASS-C
« SQL Server - AppServ-Info (SQL)
« FactoryTalk® Historian Server - AppServ-Info (Historian)
« FactoryTalk® Batch Management Server - AppServ-Batch
« FactoryTalk® Asset Management Server - AppServ-Asset
« Operator Workstation Application Server - AppServ-OWS
« Engineer Workstation Application Server - AppServ-EWS

Microsoft Windows 10 Enterprise LTSC 2019 virtual machines are as follows:

« Operator Workstation - OWS
« Engineer Workstation - EWS

This chapter describes how to set up the new operating systems after the you
power them on for the first time, complete the OOBE initializations and install
VMware Tools.

IMPORTANT  If you plan to deploy a domain controller, we recommend that you
configure the domain controller before any other system element.
See publication PROCES-UM100.

The default administrator account is often disabled to harden the operating
system. We suggest that you create an Administrator user account for each
user that requires administrative privileges. This safeguards server corruption
by restricting access to the default administrative account, and creates a
backup of critical system information. Each user can be delegated a separate
user account with password protection.

Navigate to the Control Panel.
Select User Accounts.

1

2

3. Select Manage another account.

4. Select ‘Add a user account’ below the Administrator icon.
5

Enter a name for the user that is being added, a password, retype the
password for verification, and a hint to remind you of the password.

6. Select Next, and then Finish on the next dialog box.
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Toolbar for Programs Menu

52

7. Select the user that you created.
Select ‘Change the account type’.
On the next window, select Administrator and click ‘Change

2

Account Type’.
82, Control PanelAll Control Panel ltemsiUser Accounts\Manage Accounts\Change an Account\Change Ac =] O s
« v 53_‘ <« Manage Accounts » Changean Account » Change Account Type N ] Search Cont... 0

Choose a new account type for WHilty

WHilty
R Local Account
Password protected

() Standard
Standard acceunts can use most software and change system settings that don't affect other users or the
security of this PC,

(® Administrator
Administrators have complete control over the PC. They can change any settings and access all of the files
and pregrams stored on the PC,

Why is a standard acceunt recommended?

Change Account Type Cancel

10. Sign out of Windows.
11. Press Ctrl+Alt+Insert.

IMPORTANT  Even though ‘Press Ctrl + Alt + Delete ..." is displayed on the screen,
you must press Ctrl + Alt + Insert to access the virtual machine. The
sequence 'Ctrl + Alt + Del' is reserved for the terminal from where
you connect to the server that hosts the virtual machine.

12. Log in with the user that was created.

Newer Microsoft operating systems lack the traditional Start Menu that
contains an easily navigated programs menu.

Create a traditional style program menu on the lower right side of the
Windows task bar using the following steps.

When complete, select the double arrow symbol next to Programs [l on the
task bar and launch a traditional programs menu.

1. Navigate to the Control Panel and choose File Explorer Options.

Rockwell Automation Publication 9528-UMOO1L-EN-P - August 2023




Chapter 4

Common Windows Configuration

2. On the View Tab, select ‘Show hidden files, folders, and drives’ and click

OK.

File Explorer Options

General Wiew  Search

Folder views

Y'ou can apply this view [such az Detailz or lcong] ta

i)
it

Apply to Folders

Advanced settings:

all folders of this type.

Reset Folders

Files and Folders

[ &lways show menus

Hidden files and folders

Dizplay file icon on thumbnails

~
[ Always show icons, never thumbrails
Dizplay file size information in folder tips
Dizplay the full path in the title bar

ives
(® Show hidden files, folders, and drives

[] Hide ermpty drives
[] Hide extensions for known fils types

v

Hide folder merge conflicts

0K

Restore Defaults

Cancel Apply

3. Right-click on the main windows taskbar, select Toolbars>New Toolbar.

On the New Toolbar window, navigate to your Programs folder.

C:\ProgramData\Microsoft\Windows\StartMenu\Programs

5. Click Select Folder.

The result is a custom menu with easy access to Rockwell Software

conveniently located on the Windows taskbar.

BootP-DHCP Tool
FactoryTalk Activation
FactoryTalk Alarms and Events
FactoryTalk AssetCentre Client
FactoryTalk Historian 5E
FactoryTalk Linx
FactoryTalk Tools
FactoryTalk View
Logix Designer Tools
R5Linx
RSLogix 5000 Enterprise Series
RSLogix 5000 Tools
RSMetWorx
Studic 5000 Logix Emulate
Studio5000 Task Monitor
Utilities
FactoryTalk Administration Console
[ FactoryTalk Updater
W Restart View Designer Services
8 Studio 5000

* ¥ ¥ v T wr wr wr v wwwr wrwwow

CodeMeter

Enterprise License Manager

FLASH Programming Tools
Hiprom Software

LoopPro Tuner (Rockwell Automation Edition)
Maintenance

Microsoft SQL Server 2008
Microsoft SCL Server 2012
Rockwell Automation
RockwelfSoftware

Startup

Windows Accessories
Windows Administrative Tools
Windows Ease of Access
Windows System

FactoryTalk View Studic
MiracastView

a5 Print Dialog
e Server Manager

- r ¥ v v v v v w

- vy v v v

6. Before proceeding, click the Date/Time in the lower right-hand corner of

the desktop. Verifgy that the Date and Time settings are correct.
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Rename the Computer

54

7. Turn off the ‘Set time automatically’ feature in the Date and Time
settings.

Complete these steps to rename the computer.

1. Select from the windows menu to open the Server Manager.

Server Manager

2. On the Server Manager window, select Local Server and then click the
computer name.

[ Server Manager

@ ¥ Server Manager * Local Server

- B PROPERTIES
IZ8 Dashboard . For WIN-ARAEAIFNEIM
= Computer name
B All Servers Warkgroup WORKGROUP
ii File and Storage Services P
Windows Firewall Private: On
Remote management Enabled
Remote Desktop Enabled
NIC Teaming Disabled
Ethernet( Assigned by DHCP

3. Select Change on the System Properties dialog box.

System Properties *
Computer Name  Hardware  Advanced  Femote

Windows uses the following information to identify your computer
== onthe network.

Computer description:

For example: 15 Production Server'' or
“Accounting Server'

Full computer name: WM-ARAEAIFMEIM
workgroup: WORKGROUP

To rename thiz computer or change its domain or
workgroup, click Change.

Cancel Apply

4. Type a new computer name.

IMPORTANT Do not use spaces, hyphens, or any special character symbols.
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Verify Ethernet Network

Adapter Settings

5. Select a Domain or Workgroup and click OK.

IMPORTANT  We recommend that you restart your computer so that these
changes take effect.

Enter an administrator username and password.
Select OK when the welcome to domain window appears.
Restart the virtual machine for the changes to the settings to take effect.

Log in by using your domain credentials or the local user administration
account previously created.

© © N o

The PlantPAx DCS Configuration and Implementation User Manual,
publication PROCES-UM1o00 contains configuration information procedures
for Domain or Workgroup infrastructures, such as managing IP addresses and
computer name resolution.

To help with stable communications, we recommend configuring the speed,
duplex, and power management settings for the Ethernet adapter.

IMPORTANT The configuration parameters that are described in this section
apply to typical network infrastructures recommended for PlantPAx
systems. Note that speed/duplex settings vary depending upon the
network switch configuration.

1. Navigate to the Control Panel.
2. Select Network and Sharing Center.
3. Inthe Network and Sharing Center window, select Change Adapter

Control Panel Home

Change adapter settings

Change advanced sharing
settings

See also
Internet Options

Windows Firewall

Settings.
X Control Panel\All Control Panel ltems\Network and Sharing Center [ X
&« S :‘; » Control Panel » All Control Panel ltems » Network and Sharing Center v | O Search Cont... @

View your basic network information and set up connections

View your active networks

PlantPAx.local Access type: No Internet access
Private network Connections: [ EtheretD

Change your networking settings

%t. Set up a new connection or network
=

[
|

Set up a broadband, dial-up, or VPN connection; or set up a router or access point.

Troubleshoot problems

Diagnose and repair network preblems, or get troubleshooting information,

4. Right-click the Ethernet network connection and choose Properties.
5. Ifasked, type your password and click Yes.
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Verify Remote Settings

56

6. Inthe Ethernet Properties dialog box, select Configure.

U Ethernet0 Properties
Metworking

Connect using:

@ Intel[R] 825741 Gigabit Metwork Connection

[|_Configws._|

Thiz connection uzes the following items:

et

IP File and Printer Sharing for Microsaft Networks
43008 Packet Scheduler
. Intemet Protocal Yersion 4 [TCP/IPw4)
O . Microsoft Metwork Adapter Multiplexor Protocol
. Microsoft LLDP Pratocaol Driver
| . Intemet Protocal Yersion B [TCP/PYE) W
£ >
Install... Uningtall Froperties
Description
Allows pour computer to access resources on a Microzoft
hetwork.
()3 Cancel

*

7. Choose the Advanced tab.

8. Select Speed and Duplex and then choose Auto Negotiation.

Intel(R) 825741 Gigabit Metwork Connection Properties

General Advanced Driver Details Ewvents  Power Management

The following properties are available for this network adapter. Click
the property you want to change on the left, and then select its value
on the right.

Froperty: Walue:

Mavimum RS5 Processor Mumber 4

Auto Megotiation
Packet Priority & WLAM

1.0 Gbps Full Duplex
10 Mbpz Full Duplex

10 Mbpz Half Duplex
100 kMbpz Full Duplex
100 Mbps Half Duplex
A tiation

Preferned MUMA node
Receive Bulfers
Receive Side Scaling
RSS Base Processor Mumber
5 |oad balancing profile

G Duplex

TCP Checksum Dffload [IPwd]

TCP Checksum Dffload [IPvE]
Transmit Buffers

UDP Checksum Offload [IPv4)

UDP Checksum Offload [IPvE]

“ait for Link v

9. Select the Power Management tab.

Cancel

*

10. Clear the ‘Allow the computer to turn off this device to save power’

checkbox.

11. Select OK.

Complete these steps to configure remote settings for a virtual image to allow
remote connections to this computer.

1.
2.

Right-click the Windows Start icon and choose System.

Select Remote settings.

In the Remote Assistance Section at the top of the window, verify that the
checkbox to ‘Allow Remote Assistance connections to this computer’ is

not checked.
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4. Inthe Remote Desktop Section, select the ‘Allow remote connections to
this computer’ box.

5. Select OK.

verify the Processor Complete these steps to adjust processor scheduling for best performance in
schedu“ng setting the Windows Server operating system.

1. Right-click the Windows Start icon and choose System.

2. Select the Advanced system settings.

3. Select Settings in the Performance section.

4. Choose the Advanced tab.

5

Select Background services in the Processor scheduling section to adjust
for the best performance.

6. Select OK twice.
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Notes:
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Configure PlantPAx System Servers

IMPORTANT To use the remote SQL database, a managed service account must
be created within your domain.

See: FactoryTalk AssetCentre Installation Guide, publication FTAC-
INOG5.

PlantPAx® system servers are based on Windows® Server operating systems.
This chapter describes how to configure system-specific elements and basic
Rockwell Software® setups.

Virtual templates are available for the following PlantPAx server system
elements:

« Process Automation Domain Controller - PADC

« Process Automation System Server - PASS

« SQL Server - AppServ-Info (SQL)

« FactoryTalk® Historian Server - AppServ-Info (Historian)

« FactoryTalk® Batch Management Server - AppServ-Batch

« FactoryTalk® Asset Management Server - AppServ-Asset

« Operator Workstation Application Server - AppServ-OWS

« Engineer Workstation Application Server - AppServ-EWS

The required Rockwell Automation® software for each virtual server is
included and pre-installed in the virtual image templates, but not activated.
See Software Product keys and Activations for activation procedures.

IMPORTANT  If you plan to deploy a domain controller, we recommend that you
configure the domain controller before any other system element.

A domain controller is a server that responds to security authentication
requests (logging in, checking permissions, and so forth) within the Windows
server domain. A domain grants you access to a number of network resources
(such as applications and printers) with the use of one user name and
password combination.

The PlantPAx system uses a domain controller to store user account
information, authenticate users, enforce security policies and best networking
practices such as automatic network address assignment. Domain
authentication is recommended, whether it is an existing domain or a new
one.
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Configure the PASS Virtual
Server

Configure the SQL Virtual
Server

Before configuring the domain controller, complete the following tasks:

« Deploy PlantPAx Virtual Machines.
. VMware ESXivCenter Server.

« Common Windows Configuration

Once you have completed these tasks, see the PlantPAx DCS Configuration
and Implementation User Manual, publication, PROCES-UM100, for domain
controller configuration procedures, such as:

« Creating a primary domain controller

« Creating an additional domain controller
« Configuring domain controllers

« Creating roles, areas and users

« Configuring group policy management

« Configuring group policies

« PlantPAx user policy objects

The Process Automation System Server (PASS) hosts essential software
components to run your system. The data, human-interface (HMI), and alarm
servers reside in the PASS.

The PASS hosts the FactoryTalk® Services Platform that provides a set of
common services (such as diagnostic messages, health monitoring services,
and access to real-time data).

Before configuring the PASS Server, complete the following tasks:

« Deploy PlantPAx Virtual Machines.
. VMware ESXivCenter Server.

. Common Windows Configuration

Once you have completed these tasks, see the PlantPAx DCS Configuration
and Implementation User Manual, publication, PROCES-UM100, for PASS
configuration procedures, such as:

« Configuring FactoryTalk components

« Configuring HMI, DATA, and ALARM servers
« Redundant PASS considerations

« Configuring runtime security

The AppServ-Info (SQL) server is a database that is used to store Process data
for FactoryTalk® AssetCentre, FactoryTalk Batch, and FactoryTalk Historian
Asset Framework (AF) software programs. FTLinx and FactoryTalk® Alarms
and Events server also use the SQL database.

Before configuring the server, complete the following tasks:

« Deploy PlantPAx Virtual Machines.
. VMware ESXivCenter Server.
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. Common Windows Configuration

IMPORTANT  Use this procedure if you are installing SQL Standard on this server
and are either installing a separate Historian server or are not using
a Historian server. If you install a standalone Historian Server with
SOL Express, skip this section and proceed to Configure the
Historian Virtual Server on page 69

IMPORTANT  If you install both a Historian and SOL server, Complete YMware ESXi
vCenter Server on both servers before continuing with this
procedure.

Complete SQL server 2019 Installation

1. On the virtual image desktop, click the Programs icon and choose
Microsoft® SQL server 2019>Configuration Tools>Complete SQL
Server 2019 Installation.

Azure Data Studio

Maintenance

E Complete 5QL Server 2019 Installation I Configuration Tools

Microsoft SQL Server 2019

SO Server 2019 Configuration Manager Data Quality Services Microsoft SOL Server Tools 18 »
] SQL Server 2019 Error and Usage Reporting \, SOL Server 2019 Import and Export Data (32-bit) Startup 3
W SOL Server 2018 Installation Center (54-bit) 4 SOL Server 2018 Import and Export Data (64-bit) Viware 3
Windows Accessories 3
Windows Administrative Tools  »
Windows Ease of Access 3
Windows System 3
e Microsoft Edge
= Server Manager
Ea Settings
2. Click Yes to allow the changes to be made to the device.
3. Aninstallation wizard to complete image of SQL server 2019 appears.
Complete the wizard as follows:
IMPORTANT  For the remainder of the installation, default selections are shown
and we do not recommend any changes. Some PlantPAx
configurations require these default selections. We recommend
accepting the defaults, prove the system, and make changes later.
Corresponding notice is provided where exceptions to this
configuration are considered for changing now. Otherwise, simply
click Next on the following screen captures to complete the process.
Wizard Page Action
Setup Support Rules Select OK once the rules have passed.
« Select Specify a free edition and then select Evaluation from the pull-down menu for a 90-day trial.
Product Key .
« Select Enter the product key and type your key to license your software.
License Terms Read the license terms, and select ‘Il accept the license terms’
Microsoft® Update Accept Default
Complete Image Rules Select Next once the rules have passed
Select Prepared Features Select Complete a prepared instance of SQL server 2019
Feature Review Review the features to be configured
Instance Configuration Select Default Instance
PolyBase Configuration Select Use this SQL Server as a standalone PolyBase-enabled Instance
Server Configuration Select Default
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Wizard Page

Action

Database Engine Configuration

« Select Mixed Mode
« Enter and confirm the password
« Select Add Current User

Product Key

License Terms

Global Rules

Microsoft Update
Corplete [mage Rules
Select Prepared Features
Feature Reviewr
Instance Configuration
PolyBase Configuration
Server Configuration

Database Engine C: ation

9
Analysis Services Canfiguration
Reporting Services Configuration
Feature Rules

Cornplete Image Progress

Cornplete

Database Engine Configuration

Specify Database Engine authentication security mode, administrators, data directories and TempDE settings.

Server Configuration  Data Directories  TempDB  FILESTREAM
Specify the authentication mode and administrators for the Database Engine,

Authentication Mode

() Windows authentication mode

I@ Mixed hode (S0L Server authentication and Windows authenticatinn)l

Specify the password for the SQL Server systern administrator (sa) account.

Enter password: |"""ou |

Confirm password: |"""0" |

Specify SOL Server administrators

S0L Server administrators
have unrestricted access
to the Database Engine,

| Add Current User | Add... Remowe

< Back Mext = Cancel

Analysis Services Configuration

Select Multidimensional and Data Mining Mode

Select Add Current User

Product Key

License Terms

Global Rules

Microsoft Update

Complete Image Rules

Select Prepared Features

Feature Rewviewr

Instance Configuration
PalyBase Configuration

Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Feature Rules

Complete Image Progress

Complete

Analysis Services Configuration

Specify Analysis Services server modes, administratars, and data directories,

Server Configuration  Data Directories

Server bode:

(®) Multidirmensional and Data Mining Mode
(O Tabular Mode

() PowerPivot Maode

Specify which users have administrative permissions for Analysis Services,

Analysis Services
adrninistrators hawve
unrestricted access to
Analysis Services,

| Add Current User | Add.., Remowe

< Back Mext » Cancel

Reporting Services Configuration

Select Reporting Services Native Mode > Install and Configure

Feature Rules

Select Next once the rules have passed

Complete Image Process

Select Next once Complete

Complete

Select Close to complete the wizard
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Install Historian Asset
Framework on SQL Server

Installation of FactoryTalk Historian Asset Framework (AF) software is
required to take advantage of the capabilities. Where the AF software is
installed depends upon whether a Historian Collective will be used and if a
separate SQL server is used.

If you choose to use a Historian Collective, you cannot install AF software on
either of the Historian servers. We recommend that you install FactoryTalk
Historian Asset Framework (AF) software on a separate SQL server virtual
machine. Instructions are included in the SQL server section (see page 102).

If the AF software cannot be installed on the SQL server, see the FactoryTalk
Historian SE Installation and Configuration Guide for more information on
locating your Asset Framework Server. The guide is available on the Historian
server at C:\Program Files (x86)\Common Files\Rockwell\Help.

The procedures in this section apply only if you plan to do the following:

« Use FactoryTalk Historian Asset Framework in your PlantPAx system
+ Install Asset Framework Server on the SQL Server

IMPORTANT  If you are not installing Asset Framework on the SQL Server, not
deploying a Historian server, or installing a standalone Historian or
you can skip this section. Proceed to Add Local User to the SQL

Server on page 67.

IMPORTANT The installation files are not included in the SQL Server template. The
installation files for services platform are located in the Historian
template in c:\install files\8.00.00\F THistorian\SE-DVDDL. If
Historian is already deployed on the network, access the installation
files through the network. Otherwise, the Historian template can be
downloaded from the Product Compatibility and Download Center
(PCDC) at
http://compatibility.rockwellautomation.com/Pages/home.aspx.
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FactoryTalk Historian SE installation media

1. Download the FactoryTalk Historian SE installation media.

2. Copy the Historian installation files to the local hard disk drive on the
virtual SQL server into the c:\Install Files\ directory.

3. Navigate to the installation files.
c:\Install Files\8.00.00-FTHistorian-SE-DVDDL\

Select Setup.exe.

5. Select Asset Framework from the product pull-down menu.

6 Historian SE

Setup English (United States)

- X,

Select product to install:

Asset Framework ~

--—---Single Server Deploy ment-—---—--———-
Single Server Install

Asset Frarework
Historian SE Server

Management Tools

Live Data Interface

Analysis Service

MNotifications Service

------Advanced Server Options---------——----
Advanced Server Options

Release notes
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6. Select customize and then next to accept the default configuration.
- X

6 Historian SE

Customize

m FactoryTalk Services v6,30.00
FactoryTalk Activation Manager +4.06.13
| Bsset Framework v2,10.9

[] Historian SE Server

[ ] Management Tools v3.6.3

[] Live Data Interface v2.7.1

[] Analysis Service v2.10.6

[] Motifications Service v2,10.9

Tools

(i) Total: 5.88 GB

‘Back || Nextl
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7. Select No for installing SQL Server 2019 Express. Edit the Database
server name to match the server that was previously installed. Leave
Installation Mode on the default configuration. Select Install.

AF Server Components Configuration
Install SQL Server 2019 Express? () Yes ® No

Existing SQL Server and Installation mode

Database server name
WIN-133MOVTM28P

Installation Mode

AF Application Service and AF SQL Database o

l Back || Install ‘

Specify the FactoryTalk Directory Location

After the FactoryTalk Service Platform has been installed, now is a good time to

specify the network FactoryTalk Directory location, which is typically on the
PASS.

1. Select the Programs icon and choose Rockwell Software>FactoryTalk
Tools>Specify FactoryTalk Directory Location.
2. Select Yes to allow the application to make changes to the device.

In the FactoryTalk Directory Server Location Utility dialog box, Select
Browse (ellipsis '...").

FactonyTalk Directory Server Location Utility

*
Use this dialog to change the Metwork directory that this computer belongs to. Thig setting affects all software that connects
to the Metwork, directory from this computer.
Use the FactoryT alk Directory installed on: k.

Computer hosting directory server [connected) Cancel |

|Iocalhost Help

4. Enter your FactoryTalk Directory Administration Console credentials
into the login screen and click OK.
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5. Select Remote computer and click Browse.

FactoryTalk Directory Server Configuration

Use the FactoryT alk Directory installed on:

" Thiz computer £ i
Cancel
I + RBemate computerl .

H
=
t *

IMPORTANT  Browse can be inactive if Network Discovery and File Share are not
turned on. If Browse is inactive, type the computer name of the
virtual machine that is hosting the FactoryTalk Directory.

6. Navigate the network to find the computer name of the server (typically
PASS) that is hosting the FactoryTalk Directory services. Click OK.

7. Select OK to accept the location.

FactonyTalk Directory Server Location Utility *

Use this dialog to change the Metwork directory that this computer belongs to. Thig setting affects all software that connects
to the Metwork, directory from this computer.

Use the FactoryT alk Directory installed on: ak.

Computer hosting directory server [unknown)] Cancel |

[Fass01 El I

8. Select OK to finalize the location.
9. When prompted, enter your credentials and click OK.
10. Restart after you make this change.

Add Local User to the SOL The installers for Rockwell Automation software use Windows Authentication

Server instead of SQL Server Authentication. To complete the installation of Rockwell
Automation software in system elements that connect to the SQL server, add a
local administrator account to the SQL server login. These steps are to be
performed regardless if you use a Historian server collective.

1. On thevirtual image desktop, click the Programs icon and choose
Microsoft SQL Server Tools 18>Microsoft SQL Server Management
Studio 18.

Azure Data Studio

Java

Microsoft SCL Server 2008
Microsoft SCL Server 2016
Performance Tools » Microsoft SQL Server Tools 18
Analysis Services Deployment Wizard 18 Rockwell Software
|L£ Microsoft 5OL Server Management Studio 18 | Startup

Windows Accessories

3
3
Maintenance 3
3
3

Windows Administrative Tools

Windows Ease of Access

* r v v v v

Windows System
[85] MiracastView
a5 Print Dialog
e Server Manager

E'] Settings

F'ru:ugrams.|i| A T dg 1 :
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2. On the Connect to Server dialog box, log in to the 'sa’ account with SQL

Server Authentication.
oF Connectta Server *
SQL Server
Server type: [atabaze Engine ~
Server name: |App8w-SQL‘I| v |
Avthentication: SOL Server Authentication ~
Login: |sa - |
Password: B “““““““ |
[] Remember password
Cancel Help Optionz >

3. Type the password that you created during the SQL installation (see
Configure the SQL Virtual Server).

Select Connect.

5. In the Object Explorer, right-click Security and choose New>Login.

Object Explarer v X

Connect~ 3 30 @ °F g;

= LB WM -ARAEAIFMEIM (SOL Server 11.0.70
3 Databases

=]

[ Serw Mews L4 Lagin...

3 Repl Reports b Server Rale..,

C3 Abne Credential..,

3 Man Refresh .

[ Integration Services Catalc o0l

[3 SOL Server Agent Server Sudit Specification..,

6. Select Search next to Login Name on the Login - New window.
7. Enter your security credentials.
8. On the Select User or Group dialog page, Select Advanced.

Select User ar Group *

Select this object type:

|User or Built-in zecurity principal | Object Types...

From thiz location:
|WIN-AF|AEAIFN8IM | L ..

Enter the object name to select [examples):

Check Mames

9. In the Select User or Group dialog box, Select Find Now.
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The Search Results are populated.
Select User ar Group *
Select this object type:
|User or Built-in security principal | Object Types...
Fram this location:
|WIN-AF|AEAIFN8IM | Locations...
Common Queries
o Columrs...
Starts with I
Dizabled accounts Stap
Mon expiing password
77
()8 Cancel

Search results:

In Falder

B AL APPLICS, .

B anoNyMoU .

E&Authenticated...

%Authenticatio...

82 BaTCH

B CONSOLEL...

8 CREATOR G...

8 CREATOR 0.

%] Defaulécoount WIN-ARAEAIFM...

10. In the Sea

rch Results area, select the local administrator account that is

logged in and select OK.

The ‘obj
populat

ect name’ area on the Select User or Group dialog box is

ed.

Select User or Group

Select this object type:

|User or Built-in zecurity principal | Object Types...

From this location:

[WIN-ARAEAIFNEIM || Locations..

Enter the object name to select [examples):

1M -ARAE AL FMEIMAdministrator Check Mames
Advanced.. ()3 Cancel

11. Select OK.

12. The Login

name is populated on the Login - New window.

13. Select OK.

Configure the Historian
Virtual Server

Datalink.

The first step is

This template represents a base installation of a FactoryTalk Historian SE
server. The template excludes optional features, such as Advanced Server or

to decide whether your Historian is going to be configured as a

collective of servers or as a standalone Historian server. This decision affects

the following:

Rockwell Automation Publicatiol

Where the SQL database is installed
Where the Historian Asset Framework software is installed
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Historian Collective

A Historian collective is recommended for PlantPAx systems.

A collective is composed of two or more FactoryTalk Historian servers that are
configured to store and write identical data on each server for high availability.
The server collective receives data from one or more interfaces and responds to
requests for data from one or more clients. When one server becomes
unavailable, another server that contains the same data responds to requests
for that data.

If you are implementing a collective, you must deploy two Historian server
virtual machines. Complete all sections of this manual for each Historian
server.

Before configuring the server, complete the following tasks:
« Deploy PlantPAx Virtual Machines.
« VMware ESXi vCenter Server.
« Common Windows Configuration

Once you have completed these tasks, see the PlantPAx DCS Configuration
and Implementation User Manual, publication PROCES-UMIO0, for Historian
configuration procedures, such as:

« Configuring Servers for a Collective

« Creating a Collective

« Client to server connections

« Historian to FactoryTalk Directory Connection

« Configuring Redundant Node Interfaces

« Configuring PI Performance and PI Buffering

« Configuring Data Collection

« Configuring Historian Asset Framework

Additional Historian Resources

Refer to the PlantPAx DCS Configuration and Implementation User Manual,
publication PROCES-UMIO0, for Historian configuration procedures.

When the template is installed, we recommend that you review the FactoryTalk
Historian publication at http://literature.rockwellautomation.com/idc/
groups/literature/documents/in/hse-ino2s.pdf).

IMPORTANT  See the pages that are referenced in the FactoryTalk Historian SE
Installation and Configuration Guide, publication HSE-INO25A:

« Verify that Historian Services are Running

Verify that Historian Server is Updating Data for Default Tags
Prepare PI MDB to AF Synchronization

Create Security Mappings

Adding the Server to the FactoryTalk Directory Connection
Assigning License Activations to the Historian Server
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Configure the BatCh Virtual This section provides procedures to install FactoryTalk Batch independently, with
Server FactoryTalk eProcedure’, or with Event archiver.

Before configuring the server, complete the following tasks:
« Deploy PlantPAx Virtual Machines.
. VMware ESXi vCenter Server.
« Common Windows Configuration

Specify FactoryTalk Directory Location

Complete these steps to specify the FactoryTalk Directory location.

1. On thevirtual image desktop, select the Programs icon and choose

Rockwell Software>FactoryTalk Tools>Specify FactoryTalk Directory
Location.

2. In the FactoryTalk Directory Server Location Utility dialog box, select
Browse (ellipsis "...").

FactonyTalk Directory Server Location Utility *

Use this dialog to change the Metwork directory that this computer belongs to. Thig setting affects all software that connects
to the Metwork, directory from this computer.

Use the FactoryT alk Directory installed on: ak.

Computer hosting directory server [connected) Cancel |

|:| Help

3. Inthe FactoryTalk Directory Server Configuration dialog box, select
Remote Computer.

4. Enter the name of your PASS server, or select Browse (ellipsis '..."), search
for, and select your PASS server.

|Iocalhost

FactoryTalk Directory Server Configuration *
Use the FactoryT alk Directory installed on:
" Thiz computer
LCancel
I + RBemate computerl .

IMPORTANT  Browse can be inactive if Network Discovery and File Share are not
enabled.

5. Select OK

6. On the FactoryTalk Directory Server Location Utility dialog box, select
OK to accept the changes.

FactonyTalk Directory Server Location Utility *

Use this dialog to change the Metwork directory that this computer belongs to. Thig setting affects all software that connects
to the Metwork, directory from this computer.

Use the FactoryT alk Directory installed on: ak.

Computer hosting directory server [unknown)]

Cancel |
PAS501

|:| Help

7. Login to the FactoryTalk server when prompted.
8. Restart the virtual machine.
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Install FactoryTalk Batch

The Batch virtual server provides efficient, consistent predictable batch
processing and supports the reuse of code, recipes, phases, and logic.
FactoryTalk Batch combines the ISA S88 standard with proven technology that
provides the flexibility you need to supply your product to market faster.

1. On the desktop, double-click the shortcut to the Batch Installation file
folder.

P
A

15.00.00-FTE
atch-Install

2. Double-click Setup.exe.
When the Setup window displays, select Next.

Clear the checkbox for FactoryTalk Event Archiver. Leave FactoryTalk
Batch vi15.00 checked.

@ 7

Customize

| FactoryTalk Services Platform v6.20.00
o FactoryTalk Actnation Manager w4.06.13
o FactoryTalk Lire v6.30.00
¢ [] FactoryTalk Batch v15.00
o FactoryTalk Batch View Server w2.01
[[] FacteryTalk Event Archrver Components +15.00
] FactoryTalk eProcedure Server v15.00
[] FactoryTalk Batch Material Manager v15.00
[] FactoryTalk Batch HMI Controls v2.01

] Tools
@ Total: 474G
Location:
C\Program Files (x86]\Raciowell Software E
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5. Permission requested. Check to allow changes to this computer.

@) satch

Permission Requested

Changes that will occur
Before we can continue, please agree to the following:

Groups ar COM+ Roles required for FactoryTalk Batch may be
created.
What groups and roles?

The user account specified during installation may be:
» Added to the appropriate groups
» Added to the existing Administrators group
» Used to run the FactoryTalk Batch Server Service
» Used to run the FactoryTalk Event Archiver Service

Yes, allow changes to this computer

6. Accept the defaults and select Next.

-

Options

Directory @
HTTPS Port @

| fea3
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7. Enter a user name and password for the batch server.

@ Batch

System Details

User Account

User Mame: |Administrator

Password: 'Oﬂluu{

Select Install.

9. On the EULA page, read the license agreement and click 'Accept all'.
Installation takes approximately 15 minutes.

10. Select whether to activate now or later. You must be connected to the
Internet to activate now.

11. Select Close.

Install FactoryTalk eProcedure

The eProcedure template lets you step through the process of creating and
commanding a batch. You can view equipment or procedures for batches
running within the plant.

IMPORTANT  You must have FactoryTalk Batch installed on the server to complete
the following procedure.

1. On the desktop, double-click the shortcut to the Batch Installation file
folder.

2. Double-click Setup.exe.
3. When the Setup window displays, select Customize.
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4. Check FactoryTalk eProcedure v15.00 and click Next.

@Batch

Customize

/

o FactoryTalk Senaces Platform v6.30.00
« FactoryTalk Actration Manager w0613
o FactoryTalk Linx v&30.00

i FactoryTalk Batch v15.00

' FactaryTalk Batch View Server vi.01
FactoryTalk Event Archiver Compornents v15.00
[/] FactoryTalk eProcedure Server v15.00
] FactaryTalk Batch Material Manager v15.00
FactoryTalk Batch HMI Controls v2.01
) Tools

D Tota: 424 GB

| Location:
| |CAProgram Files (xBE)\Rockwell Software l:l

=

Select Network Directory and click Next.

Enter a user name and password for the batch server.

Select Modify.

On the EULA page, read the license agreement and Select 'Accept all'.
Select Close when the modification is complete.

W N o

Install FactoryTalk Event Archiver

Complete these steps to install the FactoryTalk Event Archiver to insert batch
record data.

IMPORTANT  You must have FactoryTalk Batch installed on the server to complete
the following procedure.

1. On the desktop, double-click the shortcut to the Batch Installation file
folder.

2. Double-click Setup.exe.
When the Setup window displays, click Customize.
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4. In the FactoryTalk Batch window, select FactoryTalk Event Archiver
V14.00.

@ Batch

Customize

et 11

« FactoryTalk Services Platform v6.30.00 0.50 GB

« FactoryTalk Activation Manager v4,06.13 8

| FactoryTalk Linx v6.30.00

FactoryTalk Batch +15,00 0.12GB

« FactoryTalk Batch View Server v2.01 0
} FactoryTalk Event Archiver Components v15,00 0.0

FactoryTalk eProcedure Server v15.00

[] FactoryTalk Batch Material Manager +15.00

[] FactoryTalk Batch HMI Controls v2.01

Tools 0.21GB
(@ Total: 4.24 GB

Location:
C:\Program Files (x86)\Rockwell Software EI

5. Select Next.

6. Enter your SQL server name. Use the Default Instance, Source Name,
and Include Batch Reports.

Event Archiver SQL Connection

Server Name: MyBatchServer

Instance Name: |r-.-*sscz_:; IVER (Default Instance)

Data Source Name: | FactoryTalk Batch Events

Reporting Services
Include Batch Reports

Web Service URL:  |http://MyBatchServer:80/ReportServer

© Management Tool feature will not be installed since a
remote server name is specified for the event database.

7. Select Next.
8. Select Modify once the connection is validated.
9. On the EULA page, read the license agreement and select 'Accept all'.

10. Select Close once the modification is complete. Installation takes
approximately 3 minutes.
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Configure the Asset
Management Virtual Server

Complete Batch Installation

At this point, the FactoryTalk Batch virtual server is ready for use. Review the
Installation Guide for FactoryTalk Batch, publication BATCH-IN0O2.

We recommend that you use a domain. If the Batch server is in a workgroup,
complete these additional tasks:

« Addanincoming firewall rule

« Disable Administrative Approval Mode

For these procedures, see the Batch Installation Guide (‘Configure Batch
Server to run in a Workgroup’) and the eProcedure manual.
« The FactoryTalk Batch Installation Guide is in your template at C:\Install
Files\Batch Installation Software\15.00.00-FTBatch-DVD

« The FactoryTalk Batch Administrator’s Guide is in your template at c:\
Program Files (x86)\Commion Files\Rockwell\Help.

An asset management server (AppServ-Asset) helps to manage and maintain
plant operations. The AppServ-Asset server provides controller data backup for
disaster recovery, diagnostics, calibration, and real-time monitoring. The
server also audits equipment and network health to improve overall

resource availability.

Before configuring the server, complete the following tasks:

« Deploy PlantPAx Virtual Machines.
« VMware ESXivCenter Server

« Common Windows Configuration

Configure a Firewall

This section describes how to enable a firewall.

IMPORTANT  Before proceeding, there must be a connection between this
computer and the computer where the FactoryTalk Directory
resides. There must also be a connection between this computer
and the SOL server.

1. On the virtual image desktop, click the Programs icon and choose
Rockwell Software>FactoryTalk Tools>Windows Firewall Configuration
Utility.

2. Ifthe firewall has not been enabled, the following dialog box can open.
Select Yes to enable the firewall and continue.

Windows Firewall [ <]

‘Windows Firewall cannot run because the Windows Firewall{Internet Connection Sharing {ICS) service is not running. To use
‘Windows Firewall, you must start the Windows Firewall{ICS service, If you configure exceptions for applications or services

that were running before you started Windows Firewall, you might have to restart yvour computer so that these applications
and services run properly. Do you want Eo start the Windows Firewall/ICS service?

3. Inthe Rockwell Software Windows Firewall Configuration Utility
window, select Accept. If no changes are required, select Exit.

4. Select OK on the Confirm Windows Firewall Changes dialog box.
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5. The utility configures the Windows firewall and the firewall is set to a
new state (if different).

Specify FactoryTalk Directory Location

In this section, you specify the location of the FactoryTalk Directory.

1. On the virtual image desktop, click the Programs icon and choose

Rockwell Software>FactoryTalk Tools>Specify FactoryTalk Directory
Location.

2. Inthe FactoryTalk Directory Server Location Utility dialog box, select
Browse (ellipsis '...").

FactonyTalk Directory Server Location Utility *

Use this dialog to change the Metwork directory that this computer belongs to. Thig setting affects all software that connects
to the Metwork, directory from this computer.

Use the FactoryT alk Directory installed on: ak.

Computer hosting directory server [connected) Cancel |

Help

3. In the FactoryTalk Directory Server Configuration dialog box, select
Remote Computer. Enter the name of your PASS server, or select Browse
(ellipsis '..."), search for, and select your PASS server.

|Iocalhost

FactoryTalk Directory Server Configuration *
Use the FactoryT alk Directory installed on:
" Thiz computer
LCancel
I + RBemate computerl .

4. On the FactoryTalk Directory Server Location Utility dialog box, select
OK to accept the changes.

FactonyTalk Directory Server Location Utility *

Use this dialog to change the Metwork directory that this computer belongs to. Thig setting affects all software that connects
to the Metwork, directory from this computer.

Use the FactoryT alk Directory installed on: ak.
Computer hosting directory server [unknown)] Cancel |
PAS501

|:| Help

5. Login to the FactoryTalk server when prompted.
6. Restart the virtual machine.

Create a New Inbound Rule

There must be an inbound rule that allows a connection through the firewall to
the AppServ-Info (SQL) server.

1. On the virtual image desktop, click the Programs icon and choose
Administrative Tools>Windows Firewall with Advanced Security.

2. Inthe Windows Firewall with Advanced Security, select Inbound Rules.
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3. Right-click Inbound rules and select New Rule.

& Windows Firewsll with Advanced Security

File Action View Help
= 25 = H

Select Next.

© ® N N o

& Windows Firewall with Advance

Inbound Rules

3 Inbound' =
Outbou Plew Rule.. :
By Connec N Fr i Brorie Wy [0 rinFYES!
B Monitor b . feter Runtfme Server
feter Runtime Server
Filter by Graup ¥ feter Runtirne Server
View 5 feter Runtime Server
feter Runtime Server
Refresh feter Runtime Server
Export List.., TeterFY/Ex
atexe
iElp atexe

In the Rule Type dialog box, select Port and then select Next.
Select TCP and Specify local ports.
Type '1433' as the specific local port.

Select 'Allow the connection' and then select Next.
Make sure that all boxes are checked and select Next.

ﬂ Mew Inbound Rule Wizard

Profile

Steps:

Rule Type
Pratocol and Poits
Action

Prafile

& & & & &

Marme

Specify the profiles for which this rule applies.

‘When does this rle apply?

[~ Domain
Applies when a computer iz connected to its corporate domain,

Private

Applies when a computer is connected to a private netwerk location, such as a home
o work place,

Public
Applies when a computer is connected to a public network location.

| <Back |_:~t§xt> | [ cancel |

10. Enter External SQL Connection in the Name field and click Finish.
11. The firewall now permits connections to the external SQL server in a

secure manner.
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Configure FactoryTalk AssetCentre Software

Configure FactoryTalk AssetCentre (FTAC) server settings stored in the

FactoryTalk Directory.

1.

Navigate Programs>Rockwell Software>FactoryTalk Asset Centre
Server>Server Settings to launch the Server Setting Utility.

Enter a user name and password and click OK.
Enter the server location by typing the new computer name.

| PLANTPAX]|

%, Configure Server Settings Utility e O X
This wtility allows you to configure AssetCentre server settings stored in Factory Talk Directory.

Please note that changes made here affect the entire AssetCentre system using
this FactoryTalk Directory.

Server Location - Specify Computer Name or P address where the AssetCentre Server is located.

[] Use the secure communication channel
Select this option to have the communication between the server, clientis),
and agent(s) encrypted using the 551 protocol. | requires the S5L configuration.

Base IP Port - Specify base |P Port number to use for server services. Server services will have to
be restarted for this setting to take effect.

2 | o (01 ]

SMTP Server - Specify SMTP Email server address. This will be used to send out email
notifications from the system

SMTP Server IP Port - Specfy IP Port number forthe SMTF Server .

SMTP Server Authertication.

(®) Authenticated diients () Unauthenticated clients

System "From™ Email Address (optional) - Specify the email address for the "from™” field for all
email messages sent from AssetCentre.

QK Cancel Apply Help
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Update FactoryTalk AssetCentre SQL Instance

If the FactoryTalk AssetCentre server was installed before renaming the
computer and/or specifying a SQL database location, you must update the
FactoryTalk AssetCentre SQL server instance by using select AssetCentre
utilities.
1. On the FactoryTalk AssetCentre server computer, locate the application
utilities in the FTAC Server Repair folder on the desktop.

2. Start by running the FTAssetCentre.DBInstaller.exe utility, which will
install/upgrade the database. Enter the Server information based the
edition of SQL.

« Enter the SQL server computer name and instance for SQL Server
Standard. For example, PLANTPAXSQL\PAXINSTANCE

- Ifusing the default SQL instance, enter only the SQL server computer
name.

« Enter ".\sqlexpress" if using SQL Server Express.

#8 Database Installer *

Database Name and Version : AssetCenire 10.00.0000.352 |

Flease specify database server location.

Server |PLANTPAX‘-.SOLEXPRESS | v |

Eefore proceeding, please ensure that your Windows Active Directory (AD) user account, or a
‘windows AD group of which your user account is @ member, has been assigned the SQL Server
system administrator (S4) role in SQL Server Management Studio.

The AD user account or AD group must have administrative rights for the server upon which the
software is being installed.

Diuring installation process, the FactoryTalk AssetCentre installer will create two SQL database

users, AssetCentreUser and AssetCentreDBEMaintenance; each SQL database user shall be
assigned a randomly generated password.

Start

3. Run the FTAssetCentre.AosCatalogImport.exe utility, which imports the
AssetCentre Catalog data into the database.

o5 Import Asset Catalog Data b4

Importing Asset localized strings.

4. Make note of the FTAssetCentre.DataSourceEditWizard.exe utility. This
utility can change the system password that FactoryTalk AssetCentre
server uses to connect to the SQL Server database and can also change
the SQL Server that is used by FactoryTalk AssetCentre.
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Configure the AppServ-
OWS/AppServ-EWS Virtual
Servers

82

5. Restart FactoryTalk AssetCentre server computer.

This section describes procedures for configuring an AppServ-OWS and
AppServ-EWS. The procedure is the same for both servers.

Application servers for EWS and OWS allow multiple instances of EWS and
OWS workstations to be deployed by using Microsoft Remote Desktop
Services (RDS).

Before configuring the server, complete the following tasks:
« Deploy PlantPAx Virtual Machines.
« VMware ESXivCenter Server if deployed on a server.
« Common Windows Configuration if deployed on a workstation.

The Rockwell Automation software for the AppServ-OWS and AppServ-EWS
virtual templates is included and pre-installed in the virtual image templates,
but not activated. See Software Product keys and Activations for activation
procedures. See PlantPAx Virtual Image Template Catalog Numbers for
product catalog numbers.

IMPORTANT  If you already own individual product activations, these activations
also can be used to activate the instances of these virtual image
templates you deploy. Each instance requires its own Rockwell
Automation license and Microsoft license.

Specify the FactoryTalk Directory Location

IMPORTANT  To complete this procedure, a PASS server must be configured on
your system. The workstation being configured must have an
established connection with the PASS server.

Complete these steps to specify the network FactoryTalk Directory location for
EWS and OWS workstations.

1. Click the Programs icon and choose Rockwell Software>FactoryTalk
Tools>Specify FactoryTalk Directory Location.

2. Click Yes to allow the application to make changes to the device.

In the FactoryTalk Directory Server Location Utility dialog box, click
Browse (ellipsis '...").

FactonyTalk Directory Server Location Utility *

Use this dialog to change the Metwork directory that this computer belongs to. Thig setting affects all software that connects
to the Metwork, directory from this computer.

Use the FactoryT alk Directory installed on: ak.
Computer hosting directory server [connected) Cancel |
localhost D
| Help

4. Typeyour FactoryTalk Directory Administration Console credentials into
the login screen and click OK.
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5. Click Remote computer and click Browse.

FactoryTalk Directory Server Configuration *
Use the FactoryT alk Directory installed on:
" Thiz computer
LCancel
I + RBemate computerl .

IMPORTANT  Browse can be inactive if Network Discovery and File Share are not
turned on.

6. Navigate the network to find the computer name of the server (typically
PASS) that is hosting the FactoryTalk Directory services. Click OK.

If Browse is inactive, type the computer name of the virtual machine that
is hosting the FactoryTalk Directory.

7. Select OK to accept the location.
8. Select OK to finalize the location.

FactonyTalk Directory Server Location Utility *

Use this dialog to change the Metwork directory that this computer belongs to. Thig setting affects all software that connects
to the Metwork, directory from this computer.

Use the FactoryT alk Directory installed on: ak.
Computer hosting directory server [unknown)] Cancel |
PAS501
| D Help

9. When prompted, type the FactoryTalk Directory Administrator
username and password and click OK.

O Tip: The credentials were configured in Configure the PASS Virtual Server.

10. Restart after you make this change.

Install Pl Builder Excel Add-in for Microsoft Excel

PI Builder is a Microsoft Excel® add-in that lets you use Excel to create, view,
and modify PI points and Asset Framework objects in your Historian database.
With PI Builder, you can make bulk tag edits by importing and exporting your
spreadsheet.

All functionality of the prior PI Tag Configurator has been replaced with PI
Builder, which is included with the PI SMT and PI Data Archive setup kits (as
part of the PI AF Client installer).

IMPORTANT  This section is not performed for OWS. Proceed to Configure Remote
Desktop Services on page 84.

IMPORTANT  Microsoft Excel software must be installed for these procedures.

If Microsoft Excel was installed after the Historian software, the AF Client
features will must be modified to include the PI Builder feature.

1. Run the PI-Server_2018-SP3-Patch-1.exe file included as part of the
installation media in the \Redist\PIServer\ folder.

2. Choose to Modify the installation and click Next.
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3. Select PI Builder on the Individual Features tab and click Next.

@@ Pl Server 2018 5P3 Patch 1 Installer (Administrator) & x
Feature Selection About
Choose server roles to select typical server and client features. Fine tune your installation from the ‘Individual Features’ tab.

Maintenance Y
: . Server Roles  |Individual Featured
eature Selection

Feature Rules AF Server (%) Alrezdyinstalled (13)
Summary AF SQL database scripts - version 2.10.8.440 is installed PI Data Archive Server
Installation Progress AF SQL script execution - version 2.10.8.440 is installed :'f:;!::zfzm
Complete Pl AF Application Service - version 2.10.8.440 is installed

AF SQL script execution

Pl AF Application Service

e S N PI'SQL Data Access Server (RTQP Engine)
o P System Explorer

Pl System Explorer Management Plug-In

Pl SQL Data Access Server (RTQP Engine) - version 1.7.19246.2 is installed

[ PI Netifications Service

[ Pl Analysis Service AF Collective Manager
Client Features PI AF User Documentation

PowerShell Tools for the Pl System
Pl System Explorer - version 2.10.8.440 is installed PI System Management Tools

Pl System Explorer Management Plug-In - version 2.10.8.440 is installed Pl Module Database Builder
[ Pl Builder

AF Collective Manager - version 2,10.8.440 is installed

| AF User Documentation - version 2.10.8440 is installed
owerShell Tools for the Pl System - version 2.2.291 is installed
Pl System Management Tools - version 3.6.3.65 is installed

i L R N W
[ setectau | [ Select Typical | [ Unselect Al |

Installation directory: ‘C\Program Files\Rockwell Software\FactoryTalk Historian\PIPCY

Disk Space Requirements Update

Installation directory (x86): | C:\Program Files (x86}\Rockwell Software\FactoryTalk Historian\PIPCY

Pl Data Archive directory: |C:\Program Files\Rockwell Software\FactoryTalk Historian\Server\

< Back I MNext > I Cancel

4. Restart the computer after the installation is complete.

To retrieve and publish PI AF objects, PI Builder must connect to a PI AF
database and for PI points a PI Data Archiver server.

1. Open your version of Microsoft Excel and click the PI Builder tab.

2. Inthe Connections group on the upper left corner. Select your Data
Server, Asset Server, and Database as available.

Configure Remote Desktop Services

The AppServ-OWS and AppServ-EWS provide PlantPAx users with an
alternative to the standard OWS and EWS client machine (physical or virtual).
Both application servers use Microsoft Remote Desktop Services (RDS). RDS

technology allows multiple instances of the OWS and EWS from one virtual
server.

This architecture is ideal for PlantPAx users that use thin clients as Operator
and Engineering workstations.

IMPORTANT A valid FactoryTalk activation is still required for each instance of
the OWS and EWS that is in use.
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FactoryTalk
L i

ROS Clients
Thin Client ~|

AppServ-0WS Remote Desktop Server

Remote Desktop Session Host
FactoryTalk View SE Client
FactoryTalk Services Platform
FactoryTalk Alarms & Events
FactoryTalk Activation Client

Thin Client

AppServ-0WS
Virtual Server
AR

Thin Client

Microsoft RDS (formerly known as Terminal Services) is a standard role that is
built into the Windows server family of operating systems. RDS provides
remote access to applications and data on a remote computer over a network.
This solution minimizes the amount of information traveling across your
network.

RDS can be used as an administrative tool to connect to a remote machine and
perform maintenance tasks. RDS can also be used as a thin client solution to
let remote clients execute applications or even access the entire desktop of the
host server.

The thin client solution is a transparent system that runs applications and
performs data processing and storage functions on a remote computer. This
solution minimizes the amount of information traveling across your network.
While multiple sessions can run on one server, each user can see only their
individual session. Only the user interface is shown on client, user input from
client is redirected over the network to the remote desktop session. User's
desktops are transmitted to clients for display by using terminal emulation
software. Similarly, the software sends command functions such as keyboard
inputs and mouse clicks across the network between the client and the server.

The PlantPax AppServ-OWS and AppServ-EWS are pre-configured with the
RDS server role. This configuration provides a thin client solution for

FactoryTalk View SE clients.

Users, with the proper credentials, can log in into the AppServ-OWS and
AppServ-EWS and run the desired application.

One Rockwell Automation software activation key is required for each remote
desktop session.
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Remote Desktop Services with FactoryTalk View SE

RDS features the following benefits with FactoryTalk View SE software:

Increased network flexibility: RDS lets you deploy thin and ultrathin
clients on the plant floor or out in the field. The minimal requirements of
RDS clients allow for various thin products that are designed to handle
most environmental conditions. These conditions include radical
temperatures, extreme vibrations, or areas where mobility is key.

Users can gain access to an RDS over any Transmission Control Protocol/
Internet Protocol (TCP/IP) connection, including the following:

- Remote access

- Ethernet

- Internet

- Wireless

- Wide area network (WAN)

- Virtual private network (VPN)

Lower cost of ownership: A thin client typically consists only of the
operating system and the Remote Desktop Connection software. RDS
delivers a virtual Windows Server experience from server to clients,
regardless of what operating system the client uses.

Minimize downtime: Upgrade your entire FactoryTalk View SE
installation with one operation. Because FactoryTalk View SE products
install only on the server side, any future software upgrades are limited
to the server, making software upgrades on clients a thing of the past.

Improve data security: A FactoryTalk View SE architecture that uses RDS
is less vulnerable to security threats. RDS lets you focus your security
measures on the server because all data is processed on the server, which
you can manage in a secure location.

RDS has the following limitations with FactoryTalk View SE software:

The Microsoft RDS protocol does not transfer the physical display aspect
ratio (height/width proportion) from the server to its clients. Clients
must specify the display properties (resolution, aspect ratio, color depth,
and so forth) for each session they create. Verify the appearance of the
application visually on the Remote Desktop clients before placing the
system in a production environment, modifying graphics as necessary.

If your FactoryTalk View SE client configuration (.cli) enables 'Show
Diagnostics List', the list shows all activity from all clients that run on the
same Remote Desktop session host. Although each instance of the
FactoryTalk View SE client runs in a separate session, they are all hosted
on the same computer. And, they share common log resources. This
amount of activity can be confusing for HMI operators because they see
diagnostic activity on their client that they did not initiate.

Additional Services

IMPORTANT You can add additional role services to your server depending on

your specific deployment of RDS and connectivity needs. These
added services can add additional configuration beyond which this
base RDS has been configured for.
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Tip: Remote Desktop Services uses its own method of licensing clients that log
on to Remote Desktop Services servers. This method is separate from licensing
for the Windows Server family of operating systems. Therefore, AppServ-0WS
and AppServ-EWS Remote Desktop Connections must receive a valid license.
This license must be issued by a Remote Desktop Licensing Server before they
can log on to a Remote Desktop Session Host or Connection Broker.

For volume licensing of these components, contact your Microsoft distributor.

©
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Notes:
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Configure Windows Settings

PASS-C Virtual Template

This chapter describes how to configure the PASS-C virtual image template.

This option provides for multiple system elements to be consolidated on the
same server, which is referred to as PASS-C. Ideal for small and medium
systems, we suggest that your system not have more than 2000 I/O points for
this consolidated server.

The pre-built virtual images contain a Windows® server 2019 operating system
and pre-installed applications. The PASS-C image supports system elements
such as:

« FactoryTalk® Directory

« Data server

« HMI server (one server license only is required)

« Alarm server

« FactoryTalk® Historian

« FactoryTalk® VantagePoint®

« FactoryTalk® AssetCentre

« SQLserver

« FactoryTalk® Batch

We recommend using the AppServ-OWS / Workstation OWS virtual image
templates that contain a Microsoft® Windows 10 Enterprise LTSC 2019
operating system and supports client-side elements. The following elements
are suitable for interfacing with a PASS-C:

« HMICClient
FactoryTalk AssetCentre Client

-

Login using the administrator account and password that was created in
the previous step.

2. Inthe Product Key window, enter a valid Windows Server Product Key
and click OK.

3. Verify that the product key is correct and select Yes.

Select OK in the message window when the product key was installed
successfully.

5. Install any required drivers for your hardware (graphics, Ethernet,
chipset, and so on).
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6.

7.
8.

9.

Right-click the windows start icon and select ‘System’.

Programs and Features
Power Options

Event Viewer

Systemn

Device Manager

MNetwork Connections

Disk Management
Computer Management
Command Prompt
Command Prompt (Admin)
Task Manager

Control Panel

File Explorer

Search

Run

Shut down or sign out 3

Desktop

=g =l

Select ‘Change Settings’.
Select Change on the System Properties dialog box.

System Properties *
Computer Name  Hardware  Advanced  Femote

ta Windows uses the following information to identify your computer
= on the network.

Computer description:

For example: 15 Production Server'' or
“Accounting Server'

Full computer name: WM-ARAEAIFMEIM
workgroup: WORKGROUP

To rename this computer of change its domain ar
workgroup, click Change.

Cancel Apply

Enter the new computer name. Click OK.

IMPORTANT Do not use spaces or any special character symbols.

10. Acknowledge any prompts that indicate that a restart is required.

IMPORTANT Do not restart your computer now.

11.
12.
13.
14.

15.

Select the Advanced tab.
Select Settings in the Performance section.
Choose the Advanced tab.

Select Background services in the Processor scheduling section to adjust
for the best performance.

To help protect against viruses and security threats, select the Data
Execution Prevention tab.
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16. Select ‘Turn on DEP for essential Windows programs and services only’.

Performance Options *

Visual Effects  Advanced Data Execution Prevention

does it work:

| (® Turn on DEP for essential Windows programs and services only

(O Turn on DEP for all programs and services except those | select:

Add... Remove

Your computer's processor supports hardware-based DEP.

Cance ot

17. Acknowledge the prompt that changes take effect on restart.

IMPORTANT Do not restart your computer now.

18. Select OK to close the window.
19. On the Remote tab, select ‘Allow remote connections to this computer’.

System Properties b4
Computer Name ~ Hardware Advanced System Protection Remote
Remote Assistance
[ Allow Remote Assistance connections to this computer

What happens when | enable Remote Assistance?

Advanced...

Remote Desktop
Choose an option, and then specify who can connect.

(O Don't allow remote connections to this computer

(®) Allow remete connections to this computer

[] Allow connections only from computers running Remote
Desktop with Network Level Authentication (recommended)

Help me choose Select Users...
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20. Select OK to enable the Remote Desktop Firewall exception.

Remote Desktop Connection *

Fiemote Desktop Firewall exception will be enabled

l 5 *Y'ou choze to enable Remote Desktop Connection for
all network. connections on this computer.

To enable it for selected network, connections, open

21. Remove the check mark from the ‘Allow connections only from
computers ... box and click Apply.

IMPORTANT Do not restart your computer now.

22. Select Restart Later.

23. Navigate to the Control Panel.

24. Select Power Options.

25. Select ‘High Performance’ in the Preferred Plans section.

Control Panel Home

Choose what the power button
does

Create a power plan

[} Choosewhen toturn off the
display

W Change when the computer
sleeps

See also

Personalization

User Accounts

92

3 Contral PanelAll Control Panel lterms\Power Options - O X

“— w A @ » Control Panel » All Control Panel lterms » Power Options v O Search Co., @

Choose or customize a power plan

A power plan is a collection of hardware and systemn settings (like display brightness, sleep, etc.) that manages
how your computer uses power. Tell me more about power plans

Preferred plans

(C) Balanced (recommended) Change plan settings
Automatically balances performance with energy consumption on capable hardware.

(@ High performance Change plan settings

Favors performance, but may use more energy.

Show additional plans

Ethernet Network Adapter Settings

The PlantPAx® DCS Configuration and Implementation User Manual,

publication PROCES-UM100 contains configuration information procedures
for Domain or Workgroup infrastructures, such as managing IP addresses and
computer name resolution.

To help with stable communications, we recommend configuring the speed,
duplex, and power management settings for the Ethernet adapter.

IMPORTANT The configuration parameters that are described in this section
apply to typical network infrastructures recommended for PlantPAx
systems. Note that speed/duplex settings may vary depending upon
the network switch configuration.

1. Navigate to the Control Panel.
2. Click Network and Internet.
3. Click Network and Sharing Center.
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4. Inthe Network and Sharing Center window, click Change Adapter

Settings.
& Contrel PanelAll Control Panel ltems\Network and Sharing Center = o x
&« ~ 4 EE » Control Panel > All Control Panel ftems > Network and Sharing Center v U Search Cont... 0@

View your basic network information and set up connections
Control Panel Home

View your active networks

Change adapter settings

Change advanced sharing PlantPAx.Jocal Accesstype:  No Internet access
seftings Private network Connections: [ Ethernetd

Change your networking settings

!

Set up a new connection or netwark

Set up a broadband, dial-up, or VPN connection; or set up a router or access point.

See also

[S] Troubleshoot problems

iemetiOptions Diagnose and repair network problems, or get troubleshaoting information.

I Windows Firewall

5. Right-click the Ethernet network connection and choose Properties.
6. Ifasked, enter your password and click Yes.
7. Inthe Ethernet Properties dialog box, select Configure.

U Ethernet0 Properties *
Metworking

Connect using:

I? Intel[R] 825741 Gigabit Metwork Connection

Thiz connection uzes the following items:

’IP File and Printer Sharing for Microsaft Networks

43008 Packet Scheduler

. Intemet Protocal Yersion 4 [TCP/IPw4)

. Microsoft Metwork Adapter Multiplexor Protocol

. Microsoft LLDP Pratocaol Driver

. Intemet Protocal Yersion B [TCP/PYE) W
>

" ORORERE

Install... Uningtall Froperties

Description

Allows pour computer to access resources on a Microzoft
hetwork.

()3 Cancel

8. Select the Advanced tab.
9. Select Speed and Duplex and then choose Auto Negotiation.

Intel(R) 825741 Gigabit Metwork Connection Properties *

General Advanced Driver Details Ewvents  Power Management

The following properties are available for this network adapter. Click
the property you want to change on the left, and then select its value

on the right.

Froperty: Walue:

M aximum R55 Processor Mumber A Auta Negatiation ~
Packet Priority & WLAM 1.0 Gbns Full Duph
Preferned MUMA node : ps T Ul IupiEH

10 Mbpz Full Duplex
10 Mbpz Half Duplex
100 kMbpz Full Duplex

Receive Bulfers

Receive Side Scaling
RSS Base Processor Mumber
F55 load balancing profile

F Checksum Dfffoad [IPw4)]
TCP Checksum Dffload [IPvE]
Transmit Buffers
UDP Checksum Offload [IPv4)

UDP Checksum Offload [IPvE]
“ait for Link v

Cancel
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Configure System Software

10. Select the Power Management tab.

11. Select the ‘Allow the computer to turn off this device to save power’
checkbox.

12. Select OK.
13. Restart your computer.

The PASS-C image contains SQL server 2019 Express instance for use with
Asset Centre and other applications. This is a free edition of SQL Server, with
some limitations, a 10 GB maximum database size, and is intended for small
PlantPAx system applications.

For larger PlantPAx system applications, a standard SQL Server prepared
instance can be completed. Standard SQL server 2019 offers an evaluation
period for 180 days, before it expires and will require a licensed product key.

IMPORTANT  SOL Server Express has already been installed on this machine. If
you plan to use SQL Express, skip to SOL Registered Server Names. If

you plan to use SQL server 2019 Standard, continue with the next
procedure.

Complete SOL server 2019 Installation

Do the following if you choose to use SQL server 2019:

1. On the virtual image desktop, click the Programs icon and choose
Microsoft SQL server 2019>Configuration Tools>Complete SQL server
2019 Installation

Azure Data Studio
Maintenance 3
Microsoft SOL Server 2019
Microsoft SQL Server Tools 18
Startup

Whware

[ Complete SQL Server 2019 Installation |
SO Server 2018 Configuration Manager

] SQL Server 2019 Error and Usage Reporting
ﬁ SQL Server 2019 Installation Center (64-bit)

Configuration Tools
Data Quality Services 3
Erver mport an ort Data (32-bit]

£l SaLS 2019 Imp d Export Data (32-bi
Erver mport an ort Data (B4-bit]

£l SOLS 2019 Imp d Export Data (64-bi

3
3
3
Windows Accessories 3
Windows Administrative Tools  #
. Windows Ease of Access 3
Windows System 3
e Microsoft Edge
= Server Manager

Ea Settings

2. Click Yes to allow the changes to be made to the device.

3. Aninstallation wizard to complete image of SQL server 2019 appears.
Complete the wizard as follows:

IMPORTANT  For the remainder of the installation, default selections are shown
and we do not recommend any changes. Some PlantPAx
configurations require these default selections. We recommend
accepting the defaults, prove the system, and make changes later.
Corresponding notice is provided where exceptions to this
configuration are considered for changing now. Otherwise, simply

click Next on the following screen captures to complete the process.

9% Rockwell Automation Publication 9528-UMOOTL-EN-P - August 2023



Chapter 6 PASS-C Virtual Template

Wizard Page Action
Setup Support Rules Select OK once the rules have passed.
« Select Specify a free edition and then select Evaluation from the pull-down menu for a 90-day trial.
Product Key .
« Select Enter the product key and type your key to license your software.
License Terms Read the license terms, and select 'l accept the license terms’
Microsoft Update Accept Default

Complete Image Rules

Select Next once the rules have passed

Select Prepared Features

Select Complete a prepared instance of SQL server 2019

Feature Review

Review the features to be configured

Instance Configuration

Select Default Instance

PolyBase Configuration Select Use this SOL Server as a standalone PolyBase-enabled Instance
Server Configuration Select Default

Select Mixed Mode

Select Add Current User

Database Engine Configuration

Database Engine Configuration

Specify Database Engine authentication security mode, administrators, data directories and TempDB settings.

Product Key i Server Canfiguration | Data Directories  TernpDB  FILESTREAM

License Terms

Global Rules Specify the authentication mode and administratars for the Database Engine,
Microsoft Update Authentication Made

Cenmpllaie g ik O Windows authentication mode

Select Prepared Features - — - —
. I@ Mixed Mode (SOL Server authentication and Windows authentlcatlon)l
Feature Rewview

Instance Configuration Specify the password for the SOL Server systerm administrator (sa) account.

PalyBase Configuration Enter passward: |.........

Server Configuration

1 ; |essssBeee
Database Engine Configuration Coliine ol |

Analysis Services Configuration Specify SOL Server administrators

Reporting Services Configuration

; S0L Server administratars
Feature Rules have unrestricted access

Ready ta Complete Image to the Database Engine,

Complete Image Progress

Complete

| Add CurrentUserl Add.., Remowe

: BaCk Cance'
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Wizard Page

Action

Analysis Services Configuration

Select Multidimensional and Data Mining Mode
Select Add Current User

Analysis Services Configuration

Specify Analysis Services server modes, administrators, and data directaries,

Product Key Server Configuration  Data Directories
License Terms
Global Rules
Microsoft Update

Cornplete Image Rules

Server Mode:
(®) Multidirnensional and Data Mining Mode
O Tabular Mode

P Pivot Mod
Select Prepared Features @] R

Eeathre Renienn Specify which users have administrative permissions for Analysis Services,

Instance Configuration

PalyBase Configuration

Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Feature Rules

Ready to Complete Image

Complete Image Progress

Complete

Analysis Services
administrators hawve
unrestricted access to
Analysis Services,

Add Current User Add.., Remowe

< Back

Mext » Cancel

Reporting Services Configuration

Select Reporting Services Native Mode > Install and Configure

Feature Rules

Select Next once the rules have passed

Complete Image Process

Select Next once Complete

Complete

Select Close to complete the wizard
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SOL Registered Server Names

Use the Microsoft SQL Server Management Studio to update the registered
server names. This procedure applies to SQL Express and SQL Server.

1. Login to the computer as Administrator.
2. Navigate to Programs>Microsoft SQL Server Tool 18\Microsoft SQL
Server Management Studio 18 and launch SSMS.

Azure Data Studio

Java

Microsoft SCL Server 2008
Microsoft SCL Server 2016
Performance Tools » Microsoft SQL Server Tools 18
Analysis Services Deployment Wizard 18 Rockwell Software
|L£ Microsoft 5OL Server Management Studio 18 | Startup

Windows Accessories

3
3
Maintenance 3
3
3

Windows Administrative Tools

Windows Ease of Access

* r v v v v

Windows System
[85] MiracastView
a5 Print Dialog
e Server Manager

E'] Settings

Programs

3. Connect to the SQL server.

« For SQL Express, enter the server name\instance as
<ComputerName>\SQLEXPRESS

Login for SQLEXPRESS uses SQL Server Authentication 'sa’ account
and default password 'Rockwell1’

« For SQL Server enter the server name without instance as simply
<ComputerName>

Login for SQL Server was defined during installation.

o Connectta Server e

SQL Server

Server type: [atabaze Engine w

Server name:

Avthentication: SOL Server Authentication ~

Logir:

Pazsword:

Femember pazsword

Cancel Help Options »»

IMPORTANT  When using SQLEXPRESS, after you complete the initial connection,
you can change your sa password under Options.
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4. In SQL Server Management Studio, use the menu to select
View>Registered Servers.

I_»Q Microsoft SOL Server Management Studio (Administratar)
File  Edit  “iew  Tools  Window  Help
i - |iﬁ' - o d“|J:§‘|NeWQuery a5

| | Execute

Registered Servers > o x

@9 E B

= Local Server Groups
B PASS-Clsglexpress
B WIN-ASLIPSK2GS4
g Central Managerment Sercers

« Green icon indicates connected servers
« Blue icon indicates unconnected servers

5. Record any unconnected server names, for use in the Update SQL after
Computer Rename section.

6. Right-click any unconnected servers and select properties.

7. Use the drop-down to select the server name and then edit the registered
server name to represent this computer.

o Edit Server Registration Properties X

General  Connection Properties  Always Encrypted  Additional Connection Parareters
Login

Type the server name, or chaose it from the drop-down list,

Database Engine

Server name: ‘PASS—C\SQLEXPRESS ~ ‘
Authentication: S0L Server Authentication v
Login: |sa ~

Passuord: | ‘

Remember password

Registered senver

You can replace the registered server name with a new name and optional
server description,

Registered server name:
PASS-Chsglexpress

Registered server description:

Test | Save | Cancel Help
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Update SQL after Computer Rename

When you change the name of the computer that is running SQL, use the
following procedure to update system metadata for remote connections. This
procedure applies to SQL Express and SQL Server.

1. In SQL Server Management Studio, select 'New Query' from the toolbar.

2. Enter the following code into the SQLQuery*.sql field, replacing old
computer name with the unconnected server name recorded earlier and
supplying the new computer name.

EXEC sp_dropserver ‘<ol dconput er name>\i nstance’
(€o)
EXEC sp_addserver ' <newconput er nanme>\i nstance’ |,

| ocal
GO

,_»Q SOLQuerylsgl - PASS-Chsglexpress.master (sa (33))* - Microsoft SOL Server Management Studio (Sdministrator)
File  Edit  “iew  Project Tools  Window  Help

ie-o B o -2 R Brvaey BERRR | XAA|2-C-|H] -
| | Execute | | | |

Registered Servers v 0 x EeaelRe] - PA maste St R X
o sp_Dropserver 'WIN-ASLIPSK2GS4\SQLEXPRESS';
WoER =
= 9 Database Engine sp_addserver 'PASS-CA\SQLEXPRESS' , local;
= Local Server Groups GO
B WIN-ASLIPSK2GS4 100% -~
g Central Managerment Sercers B Messages

Commands completed successfully.

3. Select the 'Execute’ button, from the toolbar, to run the query.

To verify the update, select 'New Query' from the toolbar and enter the
following code into the SQLQuery*.sql field

sel ect * from sys. servers;

sLQuenytsgl - as. ssmaster a 53)* = > [

select * from sys.servers;|

100 % -
EH Results EH Messages

name product provider data_source
| PASS-CVSOLEWPRESS  SOL Server  SOLMCL  PASS-CASOLEXPRESS

Add New Administrator Login to SQL

Use the SQL Server Management Studio to create a security login for the new
local administrator. This procedure applies to SQL Express and SQL Server.
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1. Expand the Security folder and right-click the Logins folder to select New
Login.

Object Explarer v 1Xx

Connect~ ¥ YO A

2 @ PASS-CVSOLEXPRESS (S0OL Server 13.0.5103 - sa)
= Databases

Systern Databases
Database Snapshots
W SssetCentre

= Security

= - ]
= Mew Login... o gina
[ Filter bojind
y PE——
E Start PowverShell
M —_—
.'.'.i Reports »
ﬁ —
0 Refresh o

2. Select Search.

3. Enter 'computername\administrator’ in the object name box and select
Check Names.

B Login - Mew = | X
ST IT Script ~ 9 Help
F# General
F Server Roles
& User Mapping Lagin name: Search...
P bl
r? S:;EI: 5 ® ‘Windows authentication
(O S0L Server authentication
Select User ar Group *
Select this object type:
|User or Built-in zecurity principal | Object Types...
From this location:
|PASS'E | Locations...
Mm select [examples):
PASS-Chbdminishator | Check Names
. W Add
Connection Advanced... oK Cancel
Server
PASS-CASOLEXPRESS
4. Verify that the user is successfully verified and select OK.
5. Select Server Roles and checkboxes for public and sysadmin.
B Login - New - [m} *
Rl aoe IT Script ~ 0 Help
F General
S Teer Mapping Server role iz used to grant server-wide security privileges to a user.
& Securables
H# Status
Server roles:
[ bulkadmin
[ dbereator
[ diskadmin
rocessadmin
public
zecuntyadmin
[ serveradmin
setupadmin

12| =yzadmin

6. Select Securables and then select Search.
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7. For the Add Objects dialog, select the last option for the server

COMPUTERNAME\INSTANCE.

4 Add Objects

‘what objects do you wish to add?

(O Specific objects...
(O &l objects of the types...
(®) The server PASS-CASALEXPRESS

Cancel

Help

8. The server name appears under Securables. In the Permission section,
select Grant to enable the Connect SQL option.

B Login - New - O *
— oot - O 1
H Server Roles
K ser Mapping Login name: |F'ASS-E\Administrator |
# Securables
K Status Securables: | Search.. |
Mame Type
PASS-CASOLEXPRESS Server )
Connection
Permissions for PASS-CASOLEXPRESS:
Server Ewnlicit
PASS-CASOLEXPRESS Hpict
Connection: Permizzion Grantor Grant wiith Grant Deny -
za Connect &ny Databa... [l O O
Vi Wiew connection properties I Cannect SOL | |
Contral server [l O O
Create any database O O O
Create availability gra... O O O
Progress Create DOL event n... | O |
Ready Create endpoint O O O
Create server mls (! (! m v
>
Cancel

9. Select OK
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Delete Old Administrator Login to SQL

Prior to deleting the old administrator, use the SQL Server Management
Studio to transfer the AssetCentre database ownership to the new
administrator.

1. Totransfer AssetCentre database ownership, select ‘New Query’ from the
toolbar.

2. Enter the following code into the SQLQuery*.sql field and replace
<computername> with the current computer name.

ALTER AUTHCORI ZATI ON ON DATABASE:: AssetCentre To
[ conput er nane\ Adm ni strator];

ALTER AUTHORI ZATI ON ON DATABASE: : LLumi n_DB To
[ cormput er name\ Admi ni strator];

SQL@uerylsql - PAS...SS.master (sa (53))* & X
-JALTER AUTHORIZATION ON DATABASE::ASSETCENTRE To [PASS-C\Administrator].
ALTER AUTHORIZATION ON DATABASE::LLumin_DB To [PASS-C\Administrator];
100 % -

[g]'i Messages

Commands completed successfully.

3. Click the 'Execute’ button to run the query and change ownership.

Expand the Security>Logins folder from the SQL Server Management
Studio configuration tree.

5. Right-click on prior or unused Administrator accounts and choose
Delete.

Object Explarer vy 1Xx

Connect~ ¥ [

B @ PASS-CVSOLEXPRESS (SOL Server 13.0.5103 - sa)
=1 Databases

Systern Databases
2] Database Snapshots
W SssetCentre
= Security
= Lagins
B NS PalicyEvertProcessinglogint
B NS PalicyTaglExecutionlogirdt
AssetCentreDBMaintenance
AssetCentrellser
BUILTIMA sers
MT AUTHORITYSYSTERM
MT ServiceiMII0LES0LEXPRESS
NT SERWICENSOLTELEMETRY$SOLEXPRESS
MT SERVICENSOLWriter
PASS-ChAdministrator

EsE'EsEsEsEeEv il Ev Ko

2] Server Roles Mew Login...
Credentials Script Login as 3
Audits i
Server Audit Specifica Policies 3
Server Objects Facets
Replication
PalyBase Start PowverShell
Management Reparts 5
{¥] ¥Ewent Prafiler S —
Renarme
Delete
Refresh
Properties

6. Select OK and accept any prompts.
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Configure AssetCentre User Account

1. Right-click on AssetCentreUser under Logins and choose Properties.
2. Configure a password for the account.

B Login Properties - AssetCentrelser - [m} *
Selecta page 1T Saipt veHeIp
H# General
# Server Roles
& User Mapping Login name: |A55e1CentreU53r| | Search...
# Securables
F Status
Password: |ooooooooooooooo |
Confim p i | |

[ Specify old password

Enforce password policy
[] Enforce password expiration

i 3pp 0 =
e [] Map to Credertial
PASS-CVSOLEXPRESS
Connection: Mapped Credentials Credertial Provider
sa

Progress
Ready Default database: AssetCentre w
Default language: English v
Cancel

3. Select OK.
4. Close SQL Server Management Studio.
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Install Historian Asset Framework

The procedures in this section apply only if you plan to do the
following:

« Use FactoryTalk Historian Asset Framework in your PlantPAx system
 Install Asset Framework Server on the Server

1. Navigate to the installation files.
c:\Install Files\8.00.00-FTHistorian-SE-DVDDL\

2. Select Setup.exe.

3. Select Asset Framework from the product drop-down menu.

@ Historian SE

Setup English (United Statss)

- X,

Select product to install:

Asset Framework ~

--—---Single Server Deploy ment-—---—--———-
Single Server Install

Asset Frarework
Historian SE Server

Management Tools

Live Data Interface

Analysis Service

MNotifications Service

------Advanced Server Options---------——----
Advanced Server Options

Release notes
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4. Select customize and then next to accept the default configuration.

— X
6 Historian SE /
Customize

m FactoryTalk Services v6,30.00
FactoryTalk Activation Manager +4.06.13
| Bsset Framework v2,10.9

[] Historian SE Server

[ ] Management Tools v3.6.3

[] Live Data Interface v2.7.1

[] Analysis Service v2.10.6

[] Motifications Service v2,10.9

g Tools

(i) Total: 5.88 GB

Drive: | €& ¥ |

15.6 GB free

\aack || Nextl
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5. Select No for installing SQL Server 2019 Express. Edit the Database
server name to match the server that was previously installed. Leave
Installation Mode on the default configuration. Select Install.

@ Historian SE

AF Server Components Configuration

- X,

———

Install SQL Server 2019 Express? _) Yes ® No

Existing SQL Server and Installation mode

Database server name
WIN-133MOVTM28P

Installation Mode

AF Application Service and AF SQL Database o

[ Back |[ Install ‘

Verify the AFServers Database and Account

Complete these steps to verify that the Historian AF database and user group
were added to your computer.

1. Click the Programs icon and choose Microsoft SQL Server Tools 18 >
Microsoft SQL Server Management Studio 18.

Azure Data Studio
Java
Maintenance
Microsoft SCL Server 2008
Microsoft SCL Server 2016
Performance Tools » Microsoft SQL Server Tools 18
Analysis Services Deployment Wizard 18 Rockwell Software
|Lk: Microsoft 5OL Server Management Studio 18 | Startup

Windows Accessories

- vy v v v

Windows Administrative Tools

Windows Ease of Access

* r v v v v

Windows System
[85] MiracastView
a5 Print Dialog
e Server Manager

E} Settings

Programs

2. Enter the server name.
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« The Server name is <ComputerName> if using SQL standard
« The Server name is <ComputerName>\SQLEXPRESS’ if using SQL

Express.

IMPORTANT
Settings

<ComputerName> = The computer name set in Configure Windows

3. Logon by using the ‘sa’ account and the password.

Server type:

Server name:

Authentication:
Logir:

Pazsword:

I;Li Connect to Server

SQL Server

[atabaze Engine

SOL Server Authentication

Femember pazsword

Cancel

Help

Options »»

IMPORTANT  After you complete the initial settings, change your logon and
password settings under Options.

4. Select Connect.

5. From the SQL Server Management Studio configuration tree, expand the
Databases folder and verify that PIFD appears in the list.

Object Explorer

Connect~ ¥ ¢

B @ PASS-C (SOL Server 13.0.5102.14 - 5a)

= Databases
Systern Databases
Database Snapshots
W SssetCentre
W DConfiguration
W DvDiagnostics
W Ddueue
g FTAE
CIerol
W ReportServer
W FeportServerTernpDB
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6. Expand the Security\Logins folder and verify that the AFServers user
group was added.

Object Explorer =

Connect~ ¥ ¢
B @ PASS-C (SOL Server 13.0.5102.14 - 5a)
Databases
= Security
= Lagins
B NS PalicyEvertProcessinglogint
##hAS_PolicyTsqlExecutionLogin®#
AssetCentreDBMaintenance
AssetCentrellser
|_certSignSmbetach
MT AUTHORITYWMETWORK SERVICE
MT AUTHORITYSYSTERM
MT ServicetWSSOLSERWER
MT SERVICE\ReportSercer
MT SERVICEVSOLSERWVERAGENT
MT SERVICENSOLTELEMETRY
MT SERVICENSQL W riter
MT SERVICEVWinrmgrnt
PASS-ChAdministrator
o PASS-CVAFQueryEngines

-

7. 1fthe PIFD database or AFServers group do not appear, reinstall the
Historian Asset Framework.

8. Close SQL Server Management Studio.

Configure the FactoryTaIk 1. Navigate to the FactoryTalk Directory Configuration Wizard.
Directory y  J & BootP-DHCP Tool »

FactoryTalk Activation 3
FactoryTalk Alarms and Events 3
FactoryTalk AssetCentre Agent 3
FactoryTalk AssetCentre Client 3
FactoryTalk AssetCentre Server J
FactoryTalk Historian SE J
FactoryTalk Linx 3
Diagnostics Viewer FactoryTalk Tools

FactoryTalk Diagnestics Counter Monitor FactoryTalk View 4
FactoryTalk Directory Configuration Wizard Logix Designer Tools 4
FactoryTalk Help RSLinx 4
FactoryTalk Live Data Test Client RSLogix 5000 Enterprise Series 4
FactoryTalk Security System Configuration Guide R5Logix 5000 Tools 3

CodeMeter 3
FLASH Programming Tools 3

B&Ew-@IEYEED

Impaert R55ecurity Configuration Studio3000 Task Menitor 3 Maintenance 3
Leg On to FactoryTalk Lilities 4 Microsoft SQL Server 2008 3
RSSecurity Emulater Install Fak FactoryTalk Administration Console Microsoft SQL Server 2012 3
Specify FactoryTalk Directory Location % FactoryTalk Updater Microsoft Visual Studio 2010 2
‘Windows Firewall Configuration Utility W Restart View Designer Services Rockwell Automation 4
8 Studio 5000 Rockwell Software
Startup 3
Windows Accessories 3
Windows Administrative Tools  »
Windows Ease of Access 3
Windows System 3
FactoryTalk View Studio
MiracastView
4 Print Dialog

Server Manager
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2. Select both boxes under configure settings to configure the Network and
Local directories and click Next.

@ FactoryTalk Directory Configuration ‘Wizard *

FactoryTalk Directory Configuration

This wizard configures FactoryTalk Directory settings on this computer, & FactoryTalk Directory must
be configured before you can use this computer with vour FactoryTalk software products,

FactoryTalk Network Directory

Allows FactoryTalk software products to share centralized security and information settings across a
network,

FactoryTalk Local Directory

Allows FactoryTalk software products to share security and information settings only on this local
corpuker,

Configure settings

Select the directories you want ko configure on this computer,

[v Configure the FactoryTalk Metwork Directary

[v Configure the FactoryTalk Local Directory

‘what FactoryT alk. Directories do | need to configure? |

To continue, click Mext, Mext = | Cancel | Help

3. Enter the administrator user name and password.

IMPORTANT  Step 3 must be done twice. You have to enter a user name and
password for each directory (local and network).

4. Select Close in the summary window once complete.

Delete “Unused” Computer Names from Directory
1. Navigate to
Programs>Rockwell Software>FactoryTalk Administration Console.
2. Select Network (directory) and click OK.

3. Expand System>Computers and Groups>Computers in the explorer
pane.

4. Right-click any unused computer names and choose Delete. The original
computer name, before it was renamed, typically shows up here.

F FactoryTalk Administration Console

File View Tools Window Help

Explorer * 0 x
=-[E Metwork (THIS COMPUTER)

i FTViewDemo

i InstantFizz
- Systern

Action Groups

Policies

Cornputers and Groups
Cormputer Groups
Cormputers

B Pass-C

0 g J
s Newwor
= Users al 3
Connec Security..,
Perrnis: Properties...
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5. Ifapromptappears, select Yes.

FactonyTalk &dministration Consaole *

The selected computer 'PASS-C' is currently in use. Deleting this object

% can cause unexpected results or unstable system behavior, We strongly
recommend backing up the FactoryTalk Directory before deleting this
ohject, For details, click the Help button below,

The object "PASS-C' {'RNA:$Global$System)
$ComputersandGroups]
$Camputers/9324DFAA_SEZY_445E_SEBS_BD7S2DACE0CET is
linked to "FTAETag_Server' {'RMNA: [}
$GlobalfInstantFizz/FTAETag_Area/FTAETag_Server'y,

Do you want to delete this object?

Mo Help

6. Expand Users and Groups>User Groups in the explorer pane.

Explorer

=08 Metwork (THIS COMPUTER)
-i@ FTWiewDemo
-i@ InstantFizz
B Systern

Action Groups

=8 Palicies

-1 Computers and Groups

w5 Metworks and Devices

=11 Users and Groups

10 User Groups

28 Autherticated Users

8 PASSCUIS_IUSRS

28 Windows Adrninistrators
8 Administrators

&% Engineers

2 Maintenance
Users
=8 Connections

Permission Sets

Recreate IIS_IUSRS User Group

Ensure the IIS_IUSRS user group is a windows-linked user group by removing
the prior group and recreating for this new computer.

1. Right-click the IIS_IUSRS user group and choose Delete.
2. Select Yes.
3. Addthe IIS_IUSRS user group and link with the new computer name.
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From the Explorer pane, right-click the User Groups folder and choose

New>Windows-Linked User Group.

J FactoryTalk Administration Console

File View Tools Window Help

Explorer

* 0 x
=-[E Metwork (THIS COMPUTER)
165 System
Action Groups
=8 Policies
-1 Computers and Groups
w25 Metworks and Devices
=1 Users and Groups
- r Groups
MNew » User Group...
Seennty Windows-Linked User Group...
Engineers
Maintenance
4. Select Add.
5. Select Advanced.
Select Groups *
Select this object type:
|Gr0ups or Built-in security principals | Object Types...
From this location:
|PASS'E | Locations...
Enter the object names to select [examples]:
PASS-CMIS USRS Check Mames
6. Select Find Now, select IIS_IUSRS, and select OK.
Select Groups s
Select this object type:
|Groups or Built-in security principals | Obiject Types...
From this location:
|P>‘5t55'E | Locations...
Common Quenies
Marme: Startz with Calumns. ..
Description: | Starts with
Disabled accounts Stap

Mon expiring password

Drays since last logon:

Cancel

oK
Search results:
Name In Folder
B2 Guests PASS-C

H2 HelpLibranyUp.. PASSC
¥

B Network Confi.

H2 PdwCampute...  PASSC
5& Performance ... PASS-C

Performance PaSs-C
H2 Pl Buffer Wit PASSC
%, Fl Bulfering &... PASS-C
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7. Verify that the user group is correct, and select OK.

Explorer

=08 Metwork (THIS COMPUTER)
-i@ FTWiewDemo
-i@ InstantFizz
wfe PlantPaxDCS
B Systern
Action Groups
=8 Palicies
=1 Computers and Groups
: Cormputer Groups

-1 Cormputers

w5 Metworks and Devices

=11 Users and Groups

10 User Groups

28 Authenticated Users

vy Administrators
v Engineers

wy Maintenance
=8 Users

=8 Connections

Permission Sets

8. Restart your computer.

Configure FactoryTaIk Configure FactoryTalk AssetCentre (FTAC) server settings stored in the
AssetCentre (FTAC) Server ~ FactoryTalk Directory.

1. Navigate Programs>Rockwell Software>FactoryTalk Asset Centre
Server>Server Settings to launch the Server Setting Utility.

2. Enter a user name and password and click OK.

Enter the server location by typing the new computer name, then click
Apply.

4, Configure Server Settings Utility e O *
This utility allows you to configure AssetCentre server settings stored in Factory Talk Directory.

Please note that changes made here affect the entire AssetCentre system using
this Factory Talk Directory.

Server Location - Specify Computer Name or |P address where the AssetCentre Server is located.

[] Use the secure communication channel

Select this option to have the communication between the server, client(s),
and agent(s) encrypted using the S5L protocol. |t requires the S5 configuration.

Base IP Port - Specify base IP Port number to use for server services. Server services will have to
be restarted for this setting to take effect.

o ] v [ ]

SMTP Server - Specify SMTP Email server address. This will be used to send out email
notifications from the system.

SMTP Server IP Port - Specify IP Port number for the SMTP Server .

SMTP Server Authentication.

® Autherticated clients (O Unauthenticated clients

System "From" Email Address (optional) - Specify the email address for the “from" field for all
email messages sent from AssetCentre.

QK Cancel Apply Help
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Update FactoryTalk AssetCentre SQL Instance

If the FactoryTalk AssetCentre server was installed before renaming the
computer and/or specifying a SQL database location, you must update the
FactoryTalk AssetCentre SQL server instance by using select AssetCentre
utilities.

1. On the FactoryTalk AssetCentre server computer, locate the application

utilities in C:\Program Files (x86)\Rockwell Software\AssetCentre
Server\Bin\ directory.

M + | Bin = O X
Home Share View o

Lﬂ x Eﬁ '{*.J- iﬂ H :ﬁen = EHselectan

& cut

w-l Copy path « Ll dit Select none
aste Move Copy Delete Rename New Properties
|?] Paste shortcut to- tow - folder - EFI Invert selection
Organize MNew Open Select

Search Bin 2

MName Date modified Type 2
7 Quick access

I Deskiop Agents File folder
Backup2 File folder
l_' Dodinloads , FTACPolicyConfig.exe Application
5] Documents RAFT.TraceDiagnostics. TestApp.exe Application
=] Pictures ¢ [E| RAFTAC ArchiveCleanUp.exe Application

[&] RAFTAC Server.exe

‘a RockwellAutomation. CompareZ.exe

¥ Network @ RockwellAutomation FTAssetCentre. AosCataloglmport.exe

F;‘ RockwellAutomation. FTAssetCentre.DataSourceEditWizard.exe

ﬂ RockwellAutemation FTAssetCentre.Dbinstaller.exe
RoclkwellAutemation FTAssetCentre.DbMigrateWizard. exe

& This PC Application

Application

Application

Application

Application

Application

2. Runthe FTAssetCentre.DBInstaller.exe utility, which will install/upgrade
the database. Enter the Server information based the edition of SQL. Use
a period (.) for SQL Server Standard or enter ".\sqlexpress" if using SQL
Server Express.

48 Database Installer *

Welcome to the Databaze Inzstaller utility. Thiz application AssetCentre' f

will inztall/upgrade the database required for the application. —

D atabase Name and Yersion : AssetCentre 10.00.0000.352 |

Fleaze specify databaze server location.

Server |Pas5-CASOLEPRESS | -]

Before proceeding, please ensure that your “Windows Active Directory [AD] user account, or a
Windows AD group of which pour user account iz a member, has been assigned the SOL Server
system administrator [S4)] role in SQL Server Management Studio.

The AD uger account or AD group must have administrative rights for the server upon which the
zoftware iz being installed.

During installation process, the FactoyTalk AssetCentre installer will create two SOL databaze

users, AszsetCentrellser and AssetCentreDEMaintenance; each SOL database user shall be
azzigned a randomly generated password.
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3. Run the FTAssetCentre.AosCatalogImport.exe utility, which will import
the AssetCentre Catalog data into the database.

5! Import Asset Catalog Data b4

Gﬂssutl ntre f

st

Importing Asset localized strings.

4. Make note of the FTAssetCentre.DataSourceEditWizard.exe utility. This
utility can change the system password that FactoryTalk AssetCentre
server uses to connect to the SQL Server database and can also change
the SQL Server that is used by FactoryTalk AssetCentre.

5. Restart FactoryTalk AssetCentre server computer.

Configure FactoryTalk Remove Old Computer Names
Historian 1. Navigate to:

Programs>Rockwell Software>FactoryTalk Historian SE>FactoryTalk
Historian SE System>AboutPI-SDK

2. Inthe left pane, click Connections, right-click the old server names, and
choose Remove selected Server.

3. Close PI-SDK utility.

Install Pl Builder Excel Add-in for Microsoft Excel

PI Builder is a Microsoft Excel® add-in that lets you use Excel to create, view,
and modify PI points and Asset Framework objects in your Historian database.
With PI Builder, you can make bulk tag edits by importing and exporting your
spreadsheet.

All functionality of the prior PI Tag Configurator has been replaced with PI
Builder, which is included with the PI SMT and PI Data Archive setup kits (as
part of the PI AF Client installer).

IMPORTANT This section is not performed for OWS. Proceed to Additional
Historian Resources.

IMPORTANT Microsoft Excel 32-bit software must be installed for these
procedures.

If Microsoft Excel was installed after the Historian software, the AF Client
features will need to be modified to include the PI Builder feature.
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1. Run the PI-Server_2018-SP3-Patch-1.exe file included as part of the
installation media under the \Redist\PIServer\ folder.

2. Choose to Modify the installation and click Next.
3. Select PI Builder on the Individual Features tab and click Next

Feature Selection

Maintenance
Feature Selection
Feature Rules
Summary
Installation Progress

Complete

@ Pl Server 2018 5P3 Patch 1 Installer (Administrator) [m] *

Choose server roles to select typical server and client features. Fine tune your installation from the 'Individual Features' tab.

About

Server Roles  |Individual Featureg

AF Server
AF 501 database seripts - version 2.10.8.440 is installed
AF SOL script execution - version 2.10.8.440 is installed
Pl AF Application Service - version 2.10.8.440 is installed
P 5QL Data Access Server (RTQP Engine) - version 1.7.19246.2 is installed

(%) Aready installed (13)

PI Data Archive Server

Pl Batch Subsystem

AF SOL database scripts

AF SQL script execution

Pl AF Application Service

PI SQL Data Access Server (RTQP Engine)
Pl System Explarer

Pl System Explarer Management Plug-In
AF Collective Manager

Pl AF User Documentation

PowerShell Tools for the Pl System

Pl System Management Tools

PI Module Database Builder

Analysis and Notifications
[ PI Notifications Service
Om Analysis Service
Client Features
Pl System Explorer - version 2.10.8.440 is installed
PI System Explorer Management Plug-In - version 2.10.8.440 is installed
F Collective Manager - version 2.10.8.440 is installed
AF User Documentation - version 2,10.8.440 is installed

PowerShell Tools for the Pl System - version 2.2.2.91 is installed
Pl System Management Tools - version 3.6.3.65 is installed

Lo O RGOS T SRS V- W RO SUE I -7 CS rY
[ selectan | [ select Typical | [ Unselectail | [ Reset |
Disk Space Requirements Update
Installation directory: C:\Program Files\Rockwell Software\FactoryTalk Historian\PIPC\
Installation directory (x86): | C:\Program Files (x86)\Rockwell Software\FactoryTalk Historian\PIPC\
PI Data Archive directory: | C:\Program Files\Rackwell Software\FactoryTalk Historian\Server\
[ <Bak || Nex> ][ cancel

Insgrt

Duta Server: "I ASal ~
Bgaet Sereer: G ATHON
N Plarhio -

[atabase

4. Restart the computer after the installation is complete.

To retrieve and publish PI AF objects, PI Builder must connect to a PI AF
database and for PI points a PI Data Archiver server.

1. Open your version of Microsoft Excel and click the PI Builder tab.

2. Inthe Connections group on the upper left corner. Select your Data
Server, Asset Server, and Database as available.

Page Lipout Farmulis

TR ) Splect 201 = § m
2> vy B&HH 5
€ YDwsclect Al — Shore ka5 i
Pulshih o= PlPowsts  Librey Eloments  Beent Setuety  Ratrered
W Priek ba Termplabe - “ Fraersts = -
Budd Eatriros 1] Alribute Dets Bsfaremdn Baigurces A
i -
C o E F G H 1 J E L L L o) B Q

Rockwell Automation Publication 9528-UMOOTL-EN-P - August 2023

115



Chapter 6 PASS-C Virtual Template

Additional Historian Resources

When the template is installed, we recommend that you review a FactoryTalk
publication at http://literature.rockwellautomation.com/idc/groups/
literature/documents/in/hse-ino2s.pdf).

IMPORTANT  See the pages that are referenced in the FactoryTalk Historian SE
Installation and Configuration Guide, publication HSE-INO25A:

Verify that Historian Services are Running

Verify that Historian Server is Updating Data for Default Tags
Prepare PI MDB to AF Synchronization

Create Security Mappings

Adding the Server to the FactoryTalk Directory Connection
Assigning License Activations to the Historian Server

Install FactoryTaIk Batch The FactoryTalk® Batch virtual server provides efficient, consistent predictable
batch processing and supports the reuse of code, recipes, phases, and logic.
FactoryTalk Batch combines the ISA S88 standard with proven technology that
provides the flexibility you need to supply your product to market faster.

1. On the desktop, double-click the shortcut to the Batch Installation file
folder.

i
s

15.00.00-FTE
atch-Install

2. Double-click Setup.exe.
When the Setup window displays, select Next.

Clear the checkbox for FactoryTalk Event Archiver. Leave FactoryTalk
Batch v15.00 checked.

a Batch o - f

Customize

+ FactoryTalk Senvices Platform 630,00

o FactoryTalk Actnation Manager w4.06.13

' FactoryTalk Linzv6.30.00

[ FactoryTalk Batch v15.00

o FactoryTalk Bateh View Server v2.01

[[] FacteryTalk Event Archrver Components +15.00
FactoryTalk tProcedure Server v15.00
FactoryTalk Batch Material Manager +15.00
FactoryTalk Batch HMI Controls w201

[ Toals

Locaton:
C\Program Files (x86]\Raciowell Software E

[[tuck ][ et |

116 Rockwell Automation Publication 9528-UMOO1L-EN-P - August 2023


http://literature.rockwellautomation.com/idc/groups/literature/documents/in/hse-in025_-en-e.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/hse-in025_-en-e.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/hse-in025_-en-e.pdf

Chapter 6 PASS-C Virtual Template

5. Permission requested. Check to allow changes to this computer.

@) satch

Permission Requested

Changes that will occur
Before we can continue, please agree to the following:

Groups ar COM+ Roles required for FactoryTalk Batch may be
created.
What groups and roles?

The user account specified during installation may be:
» Added to the appropriate groups
» Added to the existing Administrators group
» Used to run the FactoryTalk Batch Server Service
» Used to run the FactoryTalk Event Archiver Service

Yes, allow changes to this computer

6. Accept the defaults and select Next.

-

Options

Directory @
HTTPS Port @

| fea3
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7. Enter a user name and password for the batch server.

@ Batch

System Details

User Account

User Mame: |Administrator

Password: 'Oﬂluu{

Select Install.

9. On the EULA page, read the license agreement and click 'Accept all'.
Installation takes approximately 15 minutes.

10. Select whether to activate now or later. You must be connected to the
Internet to activate now.

11. Select Close.

Install FactoryTalk eProcedure

The eProcedure template lets you step through the process of creating and
commanding a batch. You can view equipment or procedures for batches
running within the plant.

IMPORTANT  You must have FactoryTalk Batch installed on the server to complete
the following procedure.

1. On the desktop, double-click the shortcut to the Batch Installation file
folder.

2. Double-click Setup.exe.
3. When the Setup window displays, select Customize.
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4. Check FactoryTalk eProcedure v15.00 and click Next.

: x
| @Batch [‘

Customize

o FactoryTalk Senaces Platform v6.30.00
« FactoryTalk Actration Manager w0613
o FactoryTalk Linx v&30.00

i FactoryTalk Batch v15.00

' FactaryTalk Batch View Server vi.01
FactoryTalk Event Archiver Compornents v15.00
[/] FactoryTalk eProcedure Server v15.00
] FactaryTalk Batch Material Manager v15.00
FactoryTalk Batch HMI Controls v2.01
) Tools

D Tota: 424 GB

| Location:
| |CAProgram Files (xBE)\Rockwell Software l:l

=

Select Network Directory and click Next.

Select Modify.

W N o

Select Close when the modification is complete.

Install FactoryTalk Event Archiver

Enter a user name and password for the batch server.

On the EULA page, read the license agreement and Select 'Accept all'.

Complete these steps to install the FactoryTalk Event Archiver to insert batch

record data.

IMPORTANT  You must have FactoryTalk Batch installed on the server to complete

the following procedure.

1. On the desktop, double-click the shortcut to the Batch Installation file

folder.
2. Double-click Setup.exe.
When the Setup window displays, click Customize.

Rockwell Automation Publication 9528-UMOO1L-EN-P - August 2023

19



Chapter 6 PASS-C Virtual Template

4. In the FactoryTalk Batch window, select FactoryTalk Event Archiver
V14.00.

@ Batch

Customize

et 11

« FactoryTalk Services Platform v6.30.00 0.50 GB

« FactoryTalk Activation Manager v4,06.13 8

| FactoryTalk Linx v6.30.00

FactoryTalk Batch +15,00 0.12GB

« FactoryTalk Batch View Server v2.01 0
} FactoryTalk Event Archiver Components v15,00 0.0

FactoryTalk eProcedure Server v15.00

[] FactoryTalk Batch Material Manager +15.00

[] FactoryTalk Batch HMI Controls v2.01

Tools 0.21GB
(@ Total: 4.24 GB

Location:
C:\Program Files (x86)\Rockwell Software EI

5. Select Next.

6. Enter your SQL server name. Use the Default Instance, Source Name,
and Include Batch Reports.

Event Archiver SQL Connection

Server Name: MyBatchServer

Instance Name: |r-.-*sscz_:; IVER (Default Instance)

Data Source Name: | FactoryTalk Batch Events

Reporting Services
Include Batch Reports

Web Service URL:  |http://MyBatchServer:80/ReportServer

© Management Tool feature will not be installed since a
remote server name is specified for the event database.

7. Select Next.
8. Select Modify once the connection is validated.
9. On the EULA page, read the license agreement and select 'Accept all'.

10. Select Close once the modification is complete. Installation takes
approximately 3 minutes.
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Complete Batch Installation

At this point, the FactoryTalk Batch virtual server is ready for use. Review the
Installation Guide for FactoryTalk Batch, publication BATCH-IN0O2.

We recommend that you use a domain. If the Batch server is in a workgroup,
complete these additional tasks:

« Addanincoming firewall rule

« Disable Administrative Approval Mode

For these procedures, see the Batch Installation Guide (‘Configure Batch
Server to run in a Workgroup’) and the eProcedure manual.

« The FactoryTalk Batch Installation Guide is in your template at C:\Install
Files\Batch Installation Software\15.00.00-FTBatch-DVD

« The FactoryTalk Batch Administrator’s Guide is in your template at c:\
Program Files (x86)\Commion Files\Rockwell\Help.

Configure HMI

Once you have completed the previous tasks, see the PlantPAx DCS
Configuration and Implementation User Manual, publication PROCES-
UMi00, for PASS configuration procedures, such as:

« Configuring FactoryTalk components

« Configuring HMI, DATA, and ALARM servers

« Redundant PASS considerations

« Configuring runtime security
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Notes:
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Appendix A

Microsoft Product Keys

Software Product keys and Activations

This section discusses software activations and licenses that are required for
PlantPAx® virtual templates.

Microsoft® and Rockwell Automation require software licenses to fully utilize
their software.

« Microsoft uses a Product Key to activate the Windows® operating
system, remote desktop services, and Office apps.

« Rockwell Automation uses an Activation File to activate FactoryTalk®
software packages

The PlantPAx System 5.0 and later virtual templates utilize Windows server
2019 Standard and Windows 10 Enterprise LTSC 2019 operating systems.

Both operating systems initially power on with the Windows Out of Box
Experience (OOBE), where you have the option to enter a product key or skip
to the next step. Subsequent boots prompt to enter a product key that must be
purchased from Microsoft to activate the operating system.

Simgr.vbs Tool

If you want to do something more advanced like remove a product key, force
an online activation, or extend the activation timer, you need Slmgr.vbs.

This command-line tool is included with Windows, and provides options
unavailable in the standard activation interface that is provided on the Update
& Security > Activation screen in the Settings app

1. Right-click the Windows | | icon and choose 'Command Prompt
(Admin)'.

2. Atthe command prompt, type 'slmgr /ipk <Product key>'and press Enter
to add your volume license key.

3. Click OK when a dialog box appears informing you that the product key
installed successfully.

4. At the command prompt, type 'slmgr /ato' and press Enter to activate
Windows.

5. Click OK when a dialog box appears informing you that the product
activated successfully.

6. Close the command prompt window.
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Rockwell Automation For continuous use of FactoryTalk® products and other Rockwell Automation®

Activation Files software products, computers running the software must have access to
activation files. FactoryTalk® Activation software provides a secure, software-
based system for activating Rockwell Automation software products and
managing software activation files. With FactoryTalk Activation software,
there is no need for a physical master disk or any physical media. Instead,
activation files are generated and distributed electronically.

Concurrent activations are locked to a central activation-server computer on
the network. The activation server manages a pool of activations are assigned
automatically to clients that need them. These activations are returned
automatically to the activation server pool when the software stops running on
the client, or when the client computer shuts down.

Client computers must be configured to obtain floating activations from the
activation server. A continuous network connection is also required for clients
to use floating activations. After a client obtains a floating activation, if the
activation server detects that the client has been disconnected, the activation is
returned to the server pool.

FactoryTalk Activation Manager

FactoryTalk Activation software provides a secure, software-based system to
apply Rockwell Automation licenses for continuous use of FactoryTalk
software and other Rockwell Automation software products.

FactoryTalk Activation Manager == m] X

BOEQDR
FactoryTalk

Home Manage Activations Advanced

Welcome to FactoryTalk Activation!

You are steps away from using your Rockwell Automation product. All you have to
do is activate your Rockwell product using FactoryTalk Activation.

Ready to get started? Want to learn more?

To activate your Rockwell To learn more about FactoryTalk

product, click one of the Activation before you get

following buttons: started, click the following
button:

Find Available Activations
Learn More...

Get New Activations

Rockwell Automation
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Consideration

Details

Software that is not activated

If the components you have installed cannot be activated, for example, because the activation server is
unavailable, then the software continues to run for up to 7 days. The seven-day grace period provides time to
correct the problem with acquiring activations, without disrupting critical applications. If activation is restored
within 7 days, normal operations resume. If activation is not restored, the grace period expires. After the grace
period expires, if you restart the components and activation remains unavailable, the software runs for 2 hours
in Demo mode.

Location of activation server

Activations for Rockwell Automation software can be stored local to the system element containing the Rockwell
Automation software in question or remotely depending on your preferences and needs. Typically critical
system elements keep their activations locally in case the connection with the remote activation location is lost.
If you want to remotely activate Rockwell Automation software in non-critical system elements consider storing
them in a system element with uninterrupted connection to your PlantPAx DCS. Keep in mind the information in
Consideration section “Software that is not activated” when using a remote location for activations.

Options for adding activation files to the PASS

To make concurrent floating activations available to activation clients, first you must download the activation
files to the activation server computer, from the Rockwell Automation Activation window.

If the PASS has internet access, see ‘Open Activation Manager’ in the PlantPAx Distributed Control System
Infrastructure Configuration User Manual, publication PROCES-UM100.

If the PASS does not have internet access, the activations can be downloaded on another computer with internet
connectivity and then transferred to the PASS.

Activation file types

There are two types of activation files:

Older Flexera (.LIC) non-encrypted files that are supported by older and current software versions that can be
stored locally (C:\Users\Public\Documents\Rockwell Automation\Activations) or on a Flexra USB Dongle.

Newer CodeMeter (.wibu) encrypted files that are supported by current and future software versions that can be
stored locally (C:\ProgramData\CodeMeter\CMAct) or on a CM USB Stick.

The FactoryTalk software that is installed in the PlantPAx System 5.0 and later virtual templates are current
versions that compatible with Flexera and CodeMeter activations. CodeMeter is the preferred activation file type
going forward.
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Notes:

126 Rockwell Automation Publication 9528-UMOOTL-EN-P - August 2023



PlantPAx Distributed Control System - Templates User Manual

Rockwell Automation Publication 9528-UMOO1L-EN-P - August 2023 127



Rockwell Automation Support

Use these resources to access support information.

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification updates. rok.auto/support
Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase
Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport
Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature
:’Il;ggg;:t Compatibility and Download Center Egtvgg!oad firmware, associated files (such as AOP, EDS, and DTM), and access product release rok auto/ocde

Documentation Feedback

Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our
content, complete the form at rok.auto/docfeedback.

Waste Electrical and Electronic Equipment (WEEE)

At the end of life, this equipment should be collected separately from any unsorted municipal waste.

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec.

Allen-Bradley, ControlFLASH, ControlFLASH PLUS, FactoryTalk Logix ECHO, eProcedure, expanding human possibility, FactoryTalk, PlantPAx, Rockwell Automation, Rockwell Software, RSLinx, RSLogix 5000,
RSNetWarx, Studio 5000, Studio 5000 Architect, Studio 5000 Logix Designer, and Studio 5000 Logix Emulate are trademarks of Rockwell Automation, Inc.

ControlNet and EtherNet/IP are trademarks of ODVA, Inc.
Excel, Microsoft and Windows are trademarks of Microsoft Corporation
Trademarks not belonging to Rockwell Automation are property of their respective companies.

Rockwell Otomasyon Ticaret A.S. Kar Plaza Is Merkezi E Blok Kat:6 34752, icerenkdy, istanbul, Tel: +90 (216) 5698400 EEE Y0netmeligine Uygundur

Connect with us. H m

rockwellautomation.com expanding human possibility”

AMERICAS: Rockwell Automation, 1201 South Second Street, Milwaukee, Wl 53204-2496 USA, Tel: (1) 414.382.2000, Fax: (1) 414.382. 4444
EUROPE/MIDDLE EAST/AFRICA: Rockwell Automation NV, Pegasus Park, De Kleetlaan 12a, 1831 Diegem, Belgium, Tel: (32) 2 663 0600, Fax: (32)2 663 0640
ASIA PACIFIC: Rockwell Automation, Level 14, Core F, Cyberport 3, 100 Cyberport Road, Hong Kong, Tel: (852) 2887 4788, Fax: (852) 2508 1846
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